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Business Analysis Tools
Enterprise Architect is a sophisticated and flexible Business
Analysis modeling tool that can be used by the analyst from
planning through to product support. The tool can be used
with any Business Analysis process and there is a wide
range of features that allow analysts to work using their
preferred methods, such as Word Processor views,
Spreadsheet views, Diagrams, Relationship Matrix or a
number of other core and extended features. The analyst will
be happy in the knowledge that whatever the task is, there
will be a tool to assist them to carry out their work, and the
results will be stored in a sophisticated repository that can
be accessed by other team members who will ultimately
benefit from their work.
This Mind Map shows the landscape of the key Business
Analysis tools that can be used to develop and manage the
wide range of artefacts produced by the Business Analyst.

(c) Sparx Systems 2018
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Activity Diagram
Getting to know the Activity Diagram
Introducing The Activity diagram is one of the
the Activity Unified Modeling Language (UML)
Diagram Behavioral diagrams that can be used to
model a process or algorithm as a
sequence of steps. It is a more
sophisticated version of its close cousin
the Flowchart diagram. Activity
diagrams can be used to model Business
Processes as a UML alternative to the
BPMN Business Process diagram and
have the same ability to create a
hierarchy of Activities in the Project
Browser.
Activity Diagram showing the use of Partitions

«Class» Order

[Order Rejected]
Valid
Order?

Order Placed

Send Order

[Order Accepted]
Package Order

This diagram shows the use of
Partitions (swim lanes) to organize
the elements and these can be
orientated horizontally or
vertically They act as a container
for the elements in the Project
Browser. The diagram also shows
the use of Output and Input pins
connected by an Object flow.

«Class» Transaction

Process
Payment

Send Invoice
Invoice

(c) Sparx Systems 2018

Close Order

Customer
Payment
Invoice
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The elements can be given a name and
detailed descriptions can be added to the
notes. By connecting the Activities,
Decisions and Forks with connectors
(Control Flows) a sequence of elements
can describe the business process. A
process hierarchy can be constructed by
nesting Activities in the Project Browser
and using the child diagram functionality
to enable drill down from the value chain
level to the lowest level processes.
Where to
find the
Activity
Diagram

Ribbon: Design > Diagram > Insert >
UML Behavioral > Activity
Project Browser Toolbar : New Diagram
icon > UML Behavioral > Activity
Project Browser Context Menu | Add
Diagram... > UML Behavioral > Activity

Usage of the The Activity diagram can be used to
Activity model any business or technical activity
Diagram or notion that has a series of steps. This
includes business and technical processes
and also computer algorithms. The steps
are connected by Control Flow
relationships that show the sequencing of
the steps. Decisions and Merges can be
used to model choice and to further
(c) Sparx Systems 2018
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control the flow through the Activity.
Forks and Joins can be added to split and
reunite the flow of control and objects
added to show how data is supplied and
consumed.
Options for Activity diagrams can be drawn at
the Activity different levels of formality, from a
Diagram Basic Flow Chart style of diagram used
to represent a simple Business Process to
a sophisticated Action-based diagram
that can be used to model a complex
system. There is a toolbox that contains a
range of elements, relationships and
Patterns for creating the models.
The Activity diagram (like any diagram)
can be viewed as an Element List, which
makes working with element properties
easier.
Diagram Filters can also be used when
presenting the diagrams, to draw
attention to parts of the diagrams, and the
diagrams can be presented in hand drawn
or whiteboard style by changing the
properties of the diagram.

(c) Sparx Systems 2018
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Learn more Activity Diagram
about the
Activity
Diagram

(c) Sparx Systems 2018
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Artifact
Getting to know the Artifact
Introducing An Artifact can be used to represent an
the Artifact external file that resides outside the
repository. This is particularly useful for
making reference to external file sources
including files such as word processor
files, spreadsheets and web pages or files
reachable by a Universal Resource
Indicator (URI). They are also used for
other purposes in Enterprise Architect
such as for programming source code
files and database Tables.
The external files can be opened by
selecting the element in a diagram or the
Project Browser and pressing Ctrl+E or
the F12 key. Each file is opened either
on a separate tab in the Diagram View
workspace (if the file can be opened
within Enterprise Architect) or in the
default Windows viewer/editor for the
file type (if the file cannot be opened
within Enterprise Architect).

(c) Sparx Systems 2018
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Commencement of the North America and European
Academic Year
The solution needs to be ready for the Commencement of
the next North America and European Academic Year. The
financial modeling has factored these sales of academic
titles into the first year of revenue and the solution needs
to be available for the product entry staff to ensure the
titles are listed and ready for purchase.

Business Case - Online Bookstore
Reprint of rare and out-of-print titles
The business Case has been prepared
to articulate the solution options and
what is involved with each solution. It
recommends one option as being the
most appropriate for the
organization. It also list a number of
solution features which are
considered to be critical to a
successful result. It was written to
present to the board for the purpose
of securing funding for this strategic
A
project.

Business Analysis tools, Business Case
issues in Sparx Systems Enterprise
Architect
T his diagram shows a number of factors
that are important about the Business
Case that are time sensitive or high
value, or are important because of risk
or architectural significance. The
document is modeled using a Document
Artifact and the statements using an
Issue element.

This is a differentiating service and is expected to produce
good return on investment. There are some titles that sell
for tens of thousands of dollars and the customers are
specialized and must be treated accordingly. They include
gallery owners, national libraries, and academic
institutions.

Information and system vulnerability due to online
presence
The transition to an online presence has caused the
security architect to raise issue about the vulnerability of
systems and the information they contain. The sales force
is now global and this requires new measures to protect
sensitive information that must be accessed by the
internet and from potentially un-trusted networks.

Where to Toolbox Page: Common, Artifacts,
find the Component, Documentation,
Artifact Deployment | Artifact
Usage of the The Artifact is a powerful tool for
Artifact connecting elements in the repository
with external files or web resources. It is
particularly useful when a file such as a
spreadsheet, word processor,
presentation or other file that resides
outside the repository has to be
referenced or connected to elements
inside the repository. For example, a
Business Case might have been written
before the Enterprise Architect
repository was established, in a word
processor file stored in a corporate
document registry available through a
URL.
The file can simply be dragged onto any
Enterprise Architect diagram, which will
(c) Sparx Systems 2018
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give the user the option to create an
Artifact representing the external
document. Leaving the default name will
assign the name of the external file. A
hyperlink will be created automatically.
The Artifact in the repository acts as a
surrogate, and any number of elements
can be connected to it or Tagged Values
added to it. The external file can be
opened by simply selecting <Ctrl> <E>
or <F12> or by using the 'Launch' option
of the Artifact 'Properties' dialog.
The Artifact can be used to create
references to project management
documents or resources that are located
in a Project Management Office registry.
It is also useful to create a virtual
reference library inside Enterprise
Architect, connecting to resources that
reside outside the repository.
Options for The Artifact can be created as an
the Artifact External or an Internal file. When a file
or resource is dragged onto a diagram, a
menu will prompt the user to select the
type of Artifact to create:
· 'Hyperlink' creates a Hyperlink
element on the diagram; you can select
a sub-option to define what happens
(c) Sparx Systems 2018
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when double-clicking on the Hyperlink
- 'Open' displays the file content and
'Edit' opens it within the assigned file
editor
'Artifact (External)' creates an Artifact
element on the diagram that stores a
hyperlink to the external file; press
F12 or Ctrl+E to open the external file
'Artifact (Internal)' creates an Artifact
element on the diagram and makes a
copy of the file inside the repository;
double-clicking the Artifact launches
the internal document
'Image Asset' (graphics files only)
creates an Image element in the model
repository - the element is created in
the Package that contains the diagram
and it is displayed on the diagram;
Image elements can be displayed on a
diagram as the image itself, or as a
simple element representation
'Insert' (graphics files only) inserts the
file into the diagram as a filled
Boundary element
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Learn more Artifact
about the
Artifact

(c) Sparx Systems 2018
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Auditing
Getting to know Auditing
Introducing The Auditing feature can keep track of
Auditing the changes to Requirements including
what was changed, when it was changed
and by whom. Auditing is by default
disabled and must be enabled before the
changes to requirements will be
recorded. Once enabled it is a passive
tool that silently records the changes to
elements. It does not replace Version
Control or Baselines and in contrast to
these tools it can not be used to return to
a previous state of the model. Change
management, governance and quality
control are all aided by the use of
Auditing.

(c) Sparx Systems 2018
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Where to
find Auditing
Use of Auditing can be used to track what was
Auditing changed in a model, who changed it and
when. There are a number of modes and
a repository administrator can use the
settings to specify what is recorded in the
audit. While a baseline can be used to
show the difference between a model and
a snapshot at a point in time, the
Auditing tool records each individual
change; it can not, however, be used to
revert to a previous state.
Options for There is a wide range of settings to
Auditing configure auditing, starting with enabling
or disabling the settings that determine
which elements have an audit trail and
the level of detail recorded. Audit logs
can be exported from the repository to
increase performance.

(c) Sparx Systems 2018
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Learn more Auditing
about
Auditing

(c) Sparx Systems 2018
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Auto Names and Counters
Getting to know Auto Names and Counters
Introducing
Auto Names
and
Counters

(c) Sparx Systems 2018

To aid, regulate and enforce a naming
standard, Enterprise Architect includes
some capabilities to configure the default
names assigned to new elements of a
specific type. This is a useful feature
when dealing with complex and large
sets of requirements, but is also relevant
when dealing with smaller data sets.
Auto Names and Counters can be used to
assign a sequential number to any
element type including Requirements. It
includes a prefix definition, a counter
and a suffix definition allowing numbers
such as: 'REQ007 - Manage Inventory' to
be created.

Page 19 of 275
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Where to Ribbon: Configure > Reference Data >
find Auto Settings > Auto Names and Counters
Names and
Counters
Usage of
Auto Names
and
Counters

Analysts and others can use the
sequential number for communicating
unambiguously about the requirements
without having to use the often long
requirement name. The 'Apply on
Creation' option must be checked to start
using the auto numbering feature, this
can also be used to temporarily suspend
auto naming for example if other types
of requirements are being entered that
don't need to have sequential numbers
assigned.

Options for There are options to define the prefix,
Auto Names counter and suffix for a requirement.
and
Counters

Learn more Apply Auto Naming to Existing
about Auto
(c) Sparx Systems 2018
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Names and Elements
Counters

(c) Sparx Systems 2018
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Balanced Scorecard
Getting to know the Balanced Scorecard
Introducing Balanced Scorecard is a strategic
the Balanced diagram that allows a balanced approach
Scorecard to performance measures to be modeled.
The diagram can be created from a
Pattern that adds and connects the four
perspectives: Financial, Customer,
Internal Business Process, Learning and
Growth. Most organizations of any
appreciable size will be using some type
of Balanced Scorecard approach to align
business activities to the vision and
strategy of the organization, to monitor
performance against strategic goals and
to improve communication. The
Balanced Scorecard diagram is part of a
set of strategic diagrams that allow many
aspects of an organization's business to
be modeled.

(c) Sparx Systems 2018
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Financial Perspective
How should we appear to our shareholders?
- Broaden Revenue Base
- Improve Operating Efficiency
- Reduce Reliance of Domestic Customers

B usiness Process Perspective

Customer Perspective

What Business Processes must we excel at?
- Move to Internet Channel
- Reduce Processing Time
- Broaden Product Offering
- Understand Customer Segments

How should we appear to our Customers?

VISION
&
STRATEGY

- Product Range
- Service Excellence
- Innovative and Reliable
- Trusted Business Partner

Learning & Growth Perspective
How can we maintain our ability to change
and improve?
- Increase Employee Job Satisfaction
- Increase Employee Productivity
- Hire Internet Aware Technical Staff
- Hire multi-Channel Sales Executives

Where to
find the
Balanced
Scorecard

The Balanced Scorecard diagram is part
of the Strategic Diagrams used by
managers and others to manage
activities performed by the staff under
their control.

Ribbon: Design > Diagram > Insert >
Strategic Modeling > Balanced
Scorecard
Project Browser Toolbar : New Diagram
icon > Strategic Modeling > Balanced
Scorecard
Project Browser context menu | Add
Diagram... > Strategic Modeling >
Balanced Scorecard

Usage of the A Balanced Scorecard can be used to
Balanced ensure business activities are aligned to
(c) Sparx Systems 2018
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Scorecard the vision and strategy of the
organization, to monitor performance
against strategic goals and to improve
communication.
Options for The Classes representing the four
the Balanced Perspectives can be traced to other
Scorecard elements in the models, such as Goals
and Business Capabilities, and also to
Linked Documents that allow the
Perspectives to be documented.

Learn more Balanced Scorecard
about the
Balanced
Scorecard

(c) Sparx Systems 2018
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Baseline Tool
Getting to Know the Baseline Tool
Introducing The Baseline Tool can capture a
the Baseline snapshot of the Requirements at a point
Tool in time and then, at a later time, the
repository can be compared to this (or
another baseline) for the purpose of
determining what has changed. Any
number of baselines can be created and
labeled, and there is a baseline
comparison tool that displays the
differences between the baseline and the
model and allows the modeler to revert a
change in the model to a baseline at a
granular level.

(c) Sparx Systems 2018
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Where to Ribbon: Design > Package > Edit >
find the Manage Baselines > Manage Baselines
Baseline Tool
Usage of the Baselines are also useful when a formal
Baseline Tool requirements process is being followed
or the Requirements form part of a
contact, as the baseline can keep a
snapshot of the requirements at
important milestones such as contract
signing or requirement phase sign off.
This is also applicable to iterative and
incremental processes such as Agile
methods, as the requirements can be
baselined before or even after a Sprint.
When Requirements are still volatile and
the Requirements' owners are still
formulating their needs, a baseline can
be created to take a snapshot at important
points in the analysis phase, such as after
an elicitation workshop.
Options for There are several options that can be
the Baseline applied to configure the way the Baseline
Tool Compare tool presents information; these
are available from the Options button on
the Baselines window.

(c) Sparx Systems 2018
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Learn more Package Baselines
about the
Baseline Tool

(c) Sparx Systems 2018
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Boundary
Getting to know the Boundary
Introducing The Boundary element is derived from
the the Use Case system boundary but can
Boundary be used extensively in other contexts as a
way of describing a separation between a
system or part of a system and its
external environment. Any number of
Boundaries can be added to a diagram
and other elements such as Use Cases,
Features, Requirements, Components
and more can be placed inside the
boundary. The properties of the
Boundary can be altered to show a
number of compartments organized into
vertical and horizontal swimlanes. The
border style and opacity of the Boundary
can also be set.

(c) Sparx Systems 2018

Page 28 of 275

User Guide - Business Analysis Tools

21 December, 2018

Stakeholder Onion Diagram
Affected External Stakeholders
Katherine Celta:
Training Partner

Organization or Enterprise
Felicity NewtonJones: Human
Resources Manager

Yukiko Miakawati:
Chief Financial Officer

Affected Organizational Unit
Karl Zimmerton:
Development and
Implementation
Manager

Paul Magnolia: Test
Manager

Hamyln Piper: Chief
Financial Officer

Solution Delivery
Andre Douglas:
Chief Technical
Officer

Alessandro Taglia:
Customer
Experience Manager

Toni Rothland: Stock
Control Manager

Business Analysis tools, nested boundaries in Sparx Systems Enterprise Architect
This diagram indicates the level of involvement the stakeholders have with the solution, which
stakeholders will interact directly with the solution or participate in a business process, which are
part of the whole organization, and which are outside the organization.

Where to UML Elements Toolbar | Boundary
find the Common Toolbox Page | Boundary
Boundary
Usage of the The Boundary element is particularly
Boundary useful for defining what is inside a
system (or part of a system) and what is
outside. It can be used to show the Use
Cases of a system or subsystem, the
(c) Sparx Systems 2018

Page 29 of 275

User Guide - Business Analysis Tools

21 December, 2018

in-scope Features or Requirements.
Diagrams created for management and
non-technical audiences will benefit
from the use of Boundaries, which can
be colored and nested to have visual
appeal and business meaning. It is
essentially a diagrammatic device and
does not appear in the Project Browser.
If a formal and structural grouping of
elements is needed, the modeler could
consider the use of a Package.
Options for The Boundary can be configured to have
the a number of vertical and horizontal
Boundary swimlanes, which are useful for grouping
elements into different sections of the
boundary, creating a matrix effect. The
Border Style can also be configured to
allow different line styles that can then
be colored using the standard element
appearance settings. Also, choosing the
'Solid' options allows the Boundary's fill
color to be set.

(c) Sparx Systems 2018
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Learn more Boundary
about the
Boundary

(c) Sparx Systems 2018
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Business Process Diagram
Getting to know the Business Process
Diagram
Introducing
the Business
Process
Diagram

The Business Process diagram is part of
the Business Process Model and
Notation (BPMN) and is the main
diagram type for defining business
processes. The diagram can include
Start, Intermediate and End Events,
Business Processes, Activities,
Gateways, Pools and Lanes, and more.
The elements can be given a name and
detailed descriptions can be added to the
notes. By connecting the flow objects
with connectors, a sequence of activities,
gateways and events can describe the
business process.
Article
available
C heck availability

Ship article

yes

Financial settlement

Order received
Payment
received

no
Procurement
This BPMN Business Process
Diagram shows the use of
Intermediate Events to model
particular temporal events that
can be used to describe what
happens during the execution of a
Business Process.

late delivery
Inform customer

undeliverable

C ustomer informed

Inform customer

(c) Sparx Systems 2018

Remove article from
catalogue

Article removed
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A process hierarchy can be constructed
by nesting Business Processes and
Activities in the Project Browser and
using the child diagram functionality to
enable drill down from the value chain
level down to the lowest level processes.
Where to
find the
Business
Process
Diagram

Ribbon: Design > Diagram > Insert >
BPMN x.y > Business Process
Project Browser Toolbar : New Diagram
icon > BPMN x.y > Business Process
Project Browser context menu | Add
Diagram... > BPMN x.y > Business
Process

Usage of the
Business
Process
Diagram

Business Process diagrams can be used
to model the Business Processes in an
entire organization or part of an
organization. Business Processes can be
created to represent the current or future
state of the organization at any level of
detail from the value chain down to a
process performer level. A process
hierarchy would typically be defined that
would set the standards for the number
of levels, naming, organization of the
processes and more.

Options for Business Process diagrams can be drawn
(c) Sparx Systems 2018
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the Business at different levels of formality, from a
Process Basic Flow Chart style of diagram used
Diagram to represent a simple Business Process to
a sophisticated diagram making use of
many of the markers for Events and
Activities to describe complex business
processes. There is a toolbox that
contains a range of elements,
relationships and Patterns for creating
the models.

(c) Sparx Systems 2018
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The Business Process diagram can also
be used to generate Business Process
Execution Language (BPEL), which is
an XML language that can be ingested
by a number of tools.
The Business Process diagram (like any
diagram) can be viewed as an Element
List, which makes working with element
properties easier.
Diagram Filters can also be used when
presenting the diagrams to draw attention
to parts of the diagrams.
Learn more Business Process Diagram
about the
Business
Process
Diagram

(c) Sparx Systems 2018
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Business Process Simulation
Getting to know Business Process Simulation
Introducing
Business
Process
Simulation

(c) Sparx Systems 2018

The BPSim facility provides a way of
simulating processes written in Business
Process Model and Notation (BPMN),
providing valuable results that can be
used in process analysis. The BPMN
models are augmented with extra data as
parameters to the simulation. It allows
structural and capacity analysis to be
performed, providing for pre- and
post-execution optimization. Enterprise
Architect allows you to construct the
Business Process Models and enter the
appropriate data, which is then sent to a
BPSim Simulation engine.
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Where to
find Business
Process
Simulation

You can purchase and download the
MDG BPSim Execution Engine from the
'Products' page of the Sparx Systems
web site.

Usage of
Business
Process
Simulation

Business Process Simulation is
essentially used to mimic real world or
planned processes in a model, providing
a low cost way of determining the
effectiveness or value of a Business
Process. An analyst can assign operating
information to a model and then assess
the quality or effectiveness of the
solution based on information received
back from the Simulation engine.
Simulations can be run any number of
times adjusting configuration
information. The Simulation can be

(c) Sparx Systems 2018
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performed on current state and future
state processes as required. It is common
practice only to investigate critical or
problematic processes.
Options for
Business
Process
Simulation

The configurations created inside the
repository and the BPMN Business
Process diagrams can be exported in a
standard format and consumed by any
standards compliant BPSim engine.
Sparx Systems sells a BPSim Compliant
simulator available in the MDG BPSim
Execution Engine that allows the
simulation to be performed inside the
tool.
Simulation results can be stored in the
engine and used for cross simulation
comparison.

Learn more Business Process Simulation
about
Business
Process
Simulation

(c) Sparx Systems 2018
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Business Rules Model
Getting to know the Business Rule Model
Introducing The Business Rules Model provides a
the Business way of formally defining business rules,
Rule Model including the way they are sequenced
and the domain elements they relate to.
The model allows Business Rules to be
formally represented in a way that
prepares for the automatic generation of
application (programming) code that
would ultimately be used to implement
the rules. There are three main parts to
the notation for documenting the rules:
1. The Business Rules that express a
Policy and are applicable to a Business
Process.
2. The Business Rule Tasks that express
a task or decision that the business
processes must make.
3. The domain or information elements
that represent the vocabulary or facts
that the Business Rules relate to.
The Business Rules can also be related to
Policies (from which they derive),
(c) Sparx Systems 2018
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Requirements (which they realize) and
the application services that implement
them.
REQ173 - Domestic Shipping
rates for 24 hour delivery is
USD80

REQ174 - Domestic Shipping
rate for 2 day delivery is
USD30.00

REQ175 - Domestic Shipping
rates for > 2 days delivery is
USD2.00

Where to
find the
Business
Rule Model

«RuleTask»
Determine Domestic
Shipping Rate

Business Analysis tool, Rule
Model diagram in Sparx
Systems Enterprise
A rchitect
Business Rules are defined
using the Business Rule
element in the Rule Model
toolbox. Rules for each
specific purpose are
grouped together with their
respective Rule Task
elements using
Dependency relationships.

Ribbon: Design > Diagram > Insert >
Business Rule Model > Rule Flow, Rule
Model
Project Browser Toolbar : New Diagram
icon > Business Rule Model > Rule
Flow, Rule Model
Project Browser context menu | Add
Diagram... > Business Rules Model >
Rule Flow, Rule Model

Usage of the The Business Rules Model can be used
Business to formally model business rules and the
(c) Sparx Systems 2018
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Rule Model way they are applied in a rule task. The
model provides a useful way of
structuring the rules as a group, by
connecting them to a Rule Task that can
be related to the Business Process where
the rules are being applied. This has the
effect of reducing the clutter on a
Business Process diagram and showing
how the Business Rules apply as a set.
The important information elements and
facts can also be related to the Rule
Tasks, again reducing the clutter of
connecting individual domain elements
with specific rules.
Options for The Business Rules and the Rule Tasks
the Business can be related to Policies, Requirements,
Rule Model Business Processes and other model
elements creating an articulated model
that shows how the business rules are
applied.
Behavioral models can also be generated
from the Business Rules Models.

(c) Sparx Systems 2018
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Learn more Business Rule Model
about the
Business
Rule Model

(c) Sparx Systems 2018
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Calendar
Getting to know the Calendar
Introducing The Calendar is a fully featured
the Calendar mechanism for recording the important
events in an initiative and displaying
other information such as resource
allocation. There are day, week and
month views and the display can be set
to show Calendar entries, Project Tasks
and Resource Allocation. When a
resource has been allocated - for example
to analyze a set of requirements - a user
can drill through from the Calendar to
the requirements' location in the Project
Browser.

(c) Sparx Systems 2018
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There are also fully configurable Event
Types, Categories and colors. The work
of a Business Analyst will involve a
wide range of events including things
like: workshops, interviews, focus
groups, collaborative games,
brainstorming sessions, reviews,
observations and meetings. All of these
events can be conveniently recorded and
managed in the Calendar. When
resources have been allocated to
elements and tasks have been assigned to
individuals these can be displayed in the
Calendar.
Where to Ribbon: Start > Collaborate > Calendar
find the
Calendar
Usage of the The Calendar can be used to schedule
Calendar and view events such as meetings,
milestones, reviews, workshops and
more. It can be used to view the
allocation of resources to elements in the
repository such as who is analyzing a set
of requirements. It can also be used to
view Project Tasks. An analyst can
conveniently click through to the
elements in the Project Browser or the
(c) Sparx Systems 2018
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Project Tasks.
Options for The Calendar has a number of options
the Calendar including the ability to create recurrent
events. There is an options toolbar icon
that allows aspects of the Calendar's
appearance to be configured.

Learn more Calendar
about the
Calendar
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Class Diagram
Getting to know the Class Diagram
Introducing The Class diagram is one of the Unified
the Class Modeling Language (UML) Structural
Diagram diagrams that can be used to model a
wide range of things. It is a general
purpose diagram for modeling entities in
the business and technical domains,
including terms and concepts, Business
Rules, and Capabilities in XML and
Database Schemas.
Catalog

Line Item

Cart Item

1

1..3

1

1

0..25
1

1
Publisher

1..*
1..*

0..*

Item

1

Order

1..*

1

0..*
Author

Review

1

1

0..*

Shopping Cart

0..*
1

1

1

+billing 1 +shipping1
Address

1..*

Account
1..*

1

This diagram shows

how a class diagram

can be used to create
a conceptual model
that describes and

Legend
Editorial Review

Reader Review

Item Elements

Order Elements
Cart Elements

relates the business
vocabulary. The

elements have notes
describing their
purpose and
associations

relationships and
multiplicities

describe how they
relate to other

business terms.
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Ribbon: Design > Diagram > Insert >
UML Structural > Class
Project Browser Toolbar : New Diagram
icon > UML Structural > Class
Project Browser context menu | Add
Diagram... > UML Structural > Class

Usage of the The Class diagram can be used whenever
Class a logical or structural representation of a
Diagram system is required. It has applicability
for modeling both business and technical
concepts and can be used to model
information and structures such as XML
and database schemas.
Options for The Class diagram (like any diagram)
the Class can be viewed as an Element List, which
Diagram makes working with the element's
properties easier.
Diagram Filters can also be used when
presenting the diagrams to draw attention
to parts of the diagrams and the diagrams
can be presented as hand drawn or in a
whiteboard style by changing the
properties of the diagram.

(c) Sparx Systems 2018
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Learn more Class Diagram
about the
Class
Diagram
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Component Diagram
Getting to know the Component Diagram
Introducing
the
Component
Diagram

The Component diagram is one of the
Unified Modeling Language Structural
diagrams that can be used to model the
logical components that make up a
system. They can be used to model the
applications of an organization including
their Provided and Required Interfaces
and the information that is exchanged
between the interfaces.
Customer
Relationship
Manager

Enterprise
Resource
Planning System

Sales Data

ef
Entity
Financial

This Component Diagram shows the
use of Ports and Provided and
Required Interfaces and Information
Flows to show what information flows
between two Enterprise Systems at an
Architectural Building Block Level.

«flow»

ef
Entity
Financial

«interface»
Entity Financial
+

{abstract}

getTotalSalesValue(int, int): int

Component hierarchies can be created
that show how top levels systems or
applications are broken down to lower
level Components. The Components can
(c) Sparx Systems 2018
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be given a name, detailed descriptions
can be added and additional properties
can be added using Tagged Values.
Where to
find the
Component
Diagram

Ribbon: Design > Diagram > Insert >
UML Structural > Component
Project Browser Toolbar : New Diagram
icon > UML Structural > Component
Project Browser context menu | Add
Diagram... > UML Structural >
Component

Usage of the The Component diagram can be used to
Component model logical or physical parts of a
Diagram system including current and future state
Components. Application Architectures
often use a number of Component
diagrams to describe the architecture of
the applications and how they interact.
The interaction between the applications
can be shown using a combination of
Ports and Provided or Required
Interfaces that describe how the
Components are wired together.
Options for
the
Component
Diagram
(c) Sparx Systems 2018

Component diagrams can be drawn at a
number of levels of formality, from
simple diagrams that show the
dependencies between Components to
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sophisticated diagrams using Ports,
Interfaces and Information flows.

There is a toolbox that contains a range
of elements, relationships and Patterns
for creating Component diagrams.
The Component diagram (like any
diagram) can be viewed as an element
list that makes working with element
properties easier.
Diagram Filters can also be used when
presenting the diagrams, to draw
attention to parts of the diagrams, and the
diagrams can be presented in hand drawn
or whiteboard style by changing the
(c) Sparx Systems 2018
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properties of the diagram.
Learn more Component Diagram
about the
Component
Diagram
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Dashboard Diagrams
This diagram is an example of creating Dashboard Diagrams
in Sparx Systems Enterprise Architect. The Dashboard
Diagrams allow high quality charts and graphs to be created
to display repository information in a visually compelling
way, such as the ratio of Requirement Priorities in a pie
chart.

Getting to Know the Dashboard Diagrams
Introducing The Dashboard diagrams allow high
Dashboard quality charts and graphs to be created to
Diagrams display repository information in a
visually compelling way, such as the
ratio of Requirement Priorities in a pie
chart. There is a toolbox page of
pre-configured charts and graphs, but the
user is free to create and save any
number of charts sourcing data from
anywhere in the repository. The charts
and graphs provide valuable summary
information that assists in the
management of requirements. High level
reporting and project status can be easily
tracked and documented using the
numerous charts and report elements
(c) Sparx Systems 2018
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available that tightly link in with the
model content and status.
This diagram shows a Pie Chart
element depicting element
priority for all the requirements in
a selected package.
It provides a useful summary for a
requirements manager and is
dynamically updated when the
Priority changes and the diagram
is reopened.
There are a range of other predefined charts and user defined
charts can also be added. A filter
has been added to exclude all
elements other than
Requirements.

Where to Project Browser | Right-click on Package
find | Add Diagram :
| Manage | Show All
Dashboard Perspectives | Extended | Dashboard
Diagrams
Usage of Dashboard diagrams present compelling
Dashboard views of information - such as the status
Diagrams of Requirements in a particular release of
the system - that can be viewed inside
the model or conveniently copied
directly into management or project team
presentations. They are useful for
planning an iteration such as an Agile
sprint to view how ready the
Requirements are for the implementation
team; for example to view what
percentage of the Requirements have
been approved and are of high priority.
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Options for The Standard Charts and Graphs
Dashboard available from the Toolbox can be
Diagrams configured in a number of ways,
including changing the source, applying
filters or modifying the appearance of the
chart as indicated in this diagram,
available from the chart's Properties
window using the 'Appearance' section.

Learn more
about
Dashboard
Diagrams

(c) Sparx Systems 2018
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Data Flow Diagram
Getting to know the Data Flow Diagram
Introducing
the Data
Flow
Diagram

The Data Flow diagram (DFD) is part of
the Structured Systems Analysis and
Design Method and is used to show the
way that data flows through a system
including the Processes, Data Stores and
Entities that relate to the data.
Order
Information

Order Data Store

Order
Information

Receive
Order
Order

Order
Information

Validate
Order

Customer

Customer Profile

Customer
Preferences
Process
Order

Notification
Email Address

Ordered
Titles

Address

Send
Notification

Inventory

Ship
Order
Ordered
Items and
Bonuses

Legend
Customer Profile Data
Order Data
Inventory Data

This is a Data Flow Diagram that
shows the way that information (or
data) flows through an organization.
The modeler has chosen to use color
to make it easier to see the data
sources and where the data flows to.

A hierarch of diagrams is typically
(c) Sparx Systems 2018
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created that start from the Context
diagram, which is said to be at 'level 0' in
the hierarchy.
Where to
find the Data
Flow
Diagram

Ribbon: Design > Diagram > Insert >
Data Flow Diagrams > Data Flow
Diagram
Project Browser Toolbar : New Diagram
icon > Data Flow Diagrams > Data Flow
Diagram
Project Browser context menu | Add
Diagram... > Data Flow Diagrams > Data
Flow Diagram

Usage of the The Data Flow diagram can be used to
Data Flow create a data- and process-centric view of
Diagram a system at any level. While the BPMN
Business Process diagram is not centered
on data the Data Flow diagram is
data-centric and shows which Processes
consume, produce and store data. The
diagrams are useful for a data analyst
who needs to know how data moves
through a system, from the context level
where data flows between external
entities and through the system down to
the lowest level.
Options for The Data Flow diagram can be
(c) Sparx Systems 2018
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the Data assembled into a hierarchy, and drill
Flow down to lower level diagrams can be
Diagram achieved using the child diagram
functionality. The Processes can be
organized into a hierarchy using the
Project Browser; the child diagrams can
be nested under each Process node in the
Project Browser tree.

Colors can be used to represent particular
data and how it flows through the
system. Target and Future State diagrams
can be drawn and transitions can
describe how processes can be improved
and made more efficient.
The Data Flow diagram (like any
diagram) can be viewed as an element
list, which makes working with the
element's properties easier.
Diagram Filters can also be used when
presenting the diagrams, to draw
attention to parts of the diagrams, and the
(c) Sparx Systems 2018
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diagrams can be presented as hand drawn
or in a whiteboard style by changing the
diagram properties.
Learn more Data Flow Diagram
about the
Data Flow
Diagram
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Data Modeling Diagram
Getting to know the Data Modeling Diagram
Introducing
the Data
Modeling
Diagram

(c) Sparx Systems 2018

The Data Modeling diagram is used to
create or view graphical models of
relational database system schemas
including a range of database objects.
The diagrams can be drawn at a logical
or a physical level. When a physical
schema is being represented the modeler
can choose the correct RDBMS which
will enable the appropriate data types.
Tables, Views, Stored Procedures and
other objects are connected showing the
way they are related to each other.
Tables are the central element of the
schema and can show the contained
columns including datatypes, indexes
and keys.
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ORDER

+

«PK»
PK_Order(Integer)

+
+
+

«FK»
FK_billing(Integer)
FK_shipping(Integer)
FK_Order_Shopping Cart(Integer)

+FK_Order_Shopping Cart

«column»
Creation Date: Date
Payment Method: Payment Type
*PK orderID: Integer
*FK billing: Integer
*FK shipping: Integer
*FK shopping CartID: Integer

«FK»
(shopping CartID = shopping
C artID)

+PK_Shopping Cart
SHOPPING_CART
«column»
*PK shopping CartID: Integer
FK cart ItemID: Integer
+

«PK»
PK_Shopping Cart(Integer)

+

«FK»
FK_Shopping Cart_Cart Item(Integer)
+FK_Shopping Cart_Cart Item

Business Analysis tools, Data Modeling
diagram in Sparx Systems Enterprise
Architect

«column»
*PK cart ItemID: Integer
«PK»
+
PK_Cart Item(Integer)

+PK_Cart Item

CART_ITEM

«FK»
(cart ItemID = cart
ItemID)

This Database Modeling diagram shows a
subset of the tables that make up the
entire schema, focusing on an Order, the
Shopping Cart and the Items it contains.

Where to
find the Data
Modeling
Diagram

Ribbon: Design > Diagram > Insert >
Extended > Data Modeling
Project Browser Toolbar : New Diagram
icon > Extended > Data Modeling
Project Browser context menu | Add
Diagram... > Extended > Data Modeling

Usage of the
Data
Modeling
Diagram

The Data Modeling diagram can be used
to create database schemas or to view
schemas that have been reverse
engineered from a live database
connection or transformed from a more
primitive model. It is a useful diagram to
visualize the connections between a
variety of database objects. They can
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also be used to show traces back to other
elements such as Requirements, logical
Components, and Business Rules.
Options for
the Data
Modeling
Diagram

(c) Sparx Systems 2018

A schema can be created from scratch,
generated by a Model Transformation or
reverse engineered from an existing
database through an ODBC connection.
The schema can contain a range of
database objects, including:
· Tables
· Views
· Procedures
· Sequences
· Functions
· Associations
· Database Connections
Primary, Foreign and Unique keys can
also be modeled and displayed on the
diagram.
There are also several different notations
that can be used, including:
· Unified Modeling Language (UML)
· Information Engineering
· Integration DEFinition for Information
Modeling (IDEF 1X)
The notations can be interchanged by
changing the 'Connector Notation'
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property.
Diagram Filters can also be used when
presenting the diagrams to draw attention
to parts of the diagrams, and the
diagrams can be presented as hand drawn
or in a whiteboard style by changing the
properties of the diagram.
Learn more Data Modeling Diagram
about the
Data
Modeling
Diagram
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Database Builder
Getting to know the Database Builder
Introducing The Database Builder is the primary tool
the Database for working with data models. It is a
Builder purpose built tool that provides a single
interface for performing database-related
modeling tasks. New data models and
databases can be created or existing ones
reverse engineered into the tool. The data
modeler, database owner or
administrator can work within the tool
and can connect through to live
databases to synchronize the models with
the live databases. There is support for
most database management systems and
connections can be made to production,
pre-production, test or development
databases.
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Ribbon: Specialize > Tools > Database
Builder
Ribbon: Code > Schema > DDL > Open
the Database Builder

Usage of the The Database Builder can be used to
Database create new logical and physical data
Builder models and to generate databases from
these models. The tool can also be used
to reverse engineer any number of
existing databases into a model, allowing
models to be compared and reasoned
about.
Options for Data elements such as Tables, Views and
the Database Stored Procedures that are represented in
Builder the Database Builder can be connected to
other elements in the repository such as
(c) Sparx Systems 2018
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conceptual model elements or
Requirements, Use Cases, User Stories,
System Components and more. This
allows the models to be traced and
impact analysis to be performed creating
a relationship between these important
data representations and the rest of the
models.
There is a SQL Scratch Pad tool that can
be used to develop and execute ad-hoc
SQL queries against a live database via
an ODBC connection.

A Database Compare tool allows a data
model to be compared to a live database
and if required to be synchronized
accepting the changes in either direction.
The Execute DDL tools allows Database
Definition Language (DDL) statements
generated from the models to be
executed against a live database and for
the results to be viewed and analyzed.

Learn more Database Builder
about the
Database
(c) Sparx Systems 2018
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Builder
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Decision Tree Diagram
Getting to know the Decision Tree Diagram
Introducing
the Decision
Tree
Diagram

Decision Trees are an effective way of
graphically representing a number of
options and provide a mechanism to
investigate the possible outcomes and
benefits of choosing those options. They
can also assist the analyst to form a
balanced picture of the risks and benefits
associated with each possible course of
action. They are a close cousin of the
Decision Table but have the benefit of
being graphical. Enterprise Architect has
a purpose built diagram allowing
complex decisions to be modeled and
displayed including probabilities and
uncertainty.
Requirement not
Implemented

Stakeholder not
Interviewed
Poor Interview
Recording Processes

Missing Feature in
Implemented Solution

Requirement Not
Specified

Stakeholders Request
Overlooked
Inadequate Review
Processes
Stakeholders Request
Analysed but Excluded

No User Acceptance
Test for Feature
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Ribbon: Design > Diagram > Insert >
Strategic Modeling > Decision Tree
Project Browser Toolbar : New Diagram
icon > Strategic Modeling > Decision
Tree
Project Browser context menu | Add
Diagram... > Strategic Modeling >
Decision Tree
Decision Trees can be used to help in
decision making processes particularly
when the decision involves a complex set
of conditions that have different
likelihoods of occurrence. They can be
used for strategic or operational decision
analysis and can help to formalize the
basis of decision making particularly
when it is imperative that actions that are
taken are based on formal analysis or
have expensive consequences. A
Decision Tree can be used to present a
graphical picture of a Decision Table for
stakeholders who are more comfortable
viewing diagrams rather than tables and
documents.

Options for Decision trees can be drawn with varying
the Decision levels of formality from simple trees
Tree with a series of decisions resulting in
(c) Sparx Systems 2018
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Diagram outcomes to more formal trees that
involve uncertainty with probability
values assigned or formulaic expressions
with input parameters. The 'Decision
Tree' toolbox page contains a range of
elements that can be used, and two
Patterns that can be used to create a
diagram giving the analyst a starting
point.

Diagram Filters can also be used when
presenting the diagrams to draw attention
to parts of the diagrams and the diagrams
can be presented as hand drawn or in a
whiteboard style by changing the
properties of the diagram.
Learn more Decision Tree Diagram
about the
(c) Sparx Systems 2018
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Decision
Tree
Diagram
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Decision Table Editor
Getting to know the Decision Table Editor
Introducing The Decision Table Editor provides a
the Decision convenient and intuitive way to record
Table Editor the way that decisions are made in an
organization or industry. A number of
conditions can be defined and columns
can be added that contain values, one or
more conclusions can be added with
applicable columns where the decision
value is entered. The Decision Table
Editor is based on the Object
Management Groups (OMG) Decision
Model and Notation (DMN)
specification and can be used to generate
implementation code using predefined
macros.
An analyst will occasionally need to
record the way that decisions are made in
an organization in a formal way. There is
often also the need to express the
conditions and the resulting decisions in
a way that will assist an implementation
team design a solution. The Decision
Table Editor built into Enterprise
(c) Sparx Systems 2018

Page 72 of 275

User Guide - Business Analysis Tools

21 December, 2018

Architect can assist in expressing and
implementing the way that decisions are
made.

Where to Ribbon: Design > Impact > Decisions >
find the Manage Decisions
Decision
Table Editor
Usage of the An analyst will occasionally need to
Decision record the way that decisions are made in
Table Editor an organization in a formal way. There is
often also the need to express the
conditions and the resulting decisions in
a way that will assist an implementation
team design a solution. The Decision
Table Editor built into Enterprise
Architect can assist in expressing and
implementing the way that decisions are
made.
Options for The Decision Table Editor can be used
the Decision simply to record the conditions and the
Table Editor conclusions that form the basis of
decision making. Alternatively
(c) Sparx Systems 2018
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implementation code can be generated
using the Enterprise Architect Simulation
Library (EASL) code generation macros.
Learn more Decision Table Editor
about the
Decision
Table Editor
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Deployment Diagram
Getting to know the Deployment Diagram
Introducing
the
Deployment
Diagram

The Deployment diagram is one of the
Unified Modeling Language (UML)
Structural diagrams that can be used to
model infrastructure, including a wide
range of deployment environments. Both
physical and virtual environments can be
modeled, including infrastructure and
networking services and protocols.
NYCPROD-WEBS-002: Dell Blade Server

NYCPROD-DBS-007: Dell Blade Server

RAM = 2048
Blades = 4
Disk Controller = Raid 5

RAM = 2048 MB
Blades = 10
Disk Controller = Raid 5

«executionEnvironment»
Release 7.1: Red Hat Linux
Enterprise

«executionEnvironme...
:Red Hat Linux Enterprise

«executionE...
:Apache

192.168.0.2 / ea

216.239.46.95 / ea

«executionEnviro...
:Oracle

«executionE...
:Glassfish

This Deployment Diagram shows how
environments can be described using
building blocks from a Technical
Reference Model. The elements on this
diagram are instances and in the case of
servers are named. A Port has been used
to describe the Ethernet connection
between the two servers.

Where to Ribbon: Design > Diagram > Insert >
find the UML Structural > Deployment
(c) Sparx Systems 2018
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Deployment Project Browser Toolbar : New Diagram
Diagram icon > UML Structural > Deployment
Project Browser context menu | Add
Diagram... > UML Structural >
Deployment
Usage of the The Deployment diagram can be used to
Deployment model a wide range of infrastructure and
Diagram networking environments including
physical and virtual environments. It is
quite common to model a number of
different environments including:
production, pre-production, test and
development environments. The diagram
can be used to model Servers, Devices,
Networks, Execution Environments.
Switches, Routers, IP Addresses and the
software components and Artifacts
deployed.
Options for
the
Deployment
Diagram

(c) Sparx Systems 2018

It is quite common to use the
Deployment diagram to model a number
of different environments, including
production, pre-production, test and
development environments. Alternative
images can be used in diagrams to
represent infrastructure and networking
devices, such as Networks, Servers,
Routers, Switches and more, making the
diagrams more compelling and appealing
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to their audience. The diagrams can be
included in documentation generated
automatically using the Document
Generator.

There is a toolbox that contains a range
of elements, relationships and Patterns
for creating Deployment diagrams.
The Deployment diagram (like any
diagram) can be viewed as an element
list, which makes working with element
properties easier.
Diagram Filters can also be used when
presenting the diagrams, to draw
(c) Sparx Systems 2018
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attention to parts of the diagrams; the
diagrams can be presented in hand drawn
or whiteboard style by changing the
properties of the diagram.
Learn more Deployment Diagram
about the
Deployment
Diagram
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Document Artifact
Getting to know the Document Artifact
Introducing
the
Document
Artifact
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A Document Artifact is like a word
processor file that can be created and
stored directly inside the model to record
structured documentation. It is a
light-weight and convenient alternative
to creating a document in your favorite
word processor. It has many of the
features you would expect in a word
processing tool, and allows you to create
hyperlinks to content in the modeling
Repository. An analyst will often be
required to create structured
documentation in addition to what might
properly be placed in an element's notes
or in a corporate document repository.
This could include things such as
interview plans, focus group agendas,
surveys and more. There is rarely a
requirement to store this type of
documentation in a corporate document
repository, and storing them inside the
modeling repository has many benefits,
including being able to include
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hyperlinks to elements and diagrams
contained in the Project Browser.

Where to
find the
Document
Artifact

Toolbox: Common, Artifacts,
Component, Documentation,
Deployment Toolbox Page | Document
Artifact

Usage of the A Document Artifact can be used to add
Document structured documentation in the form of
Artifact a word processor (rtf) file. This can be a
standalone element or it can be linked to
another model element. In large
organizations there is often a corporate
repository for documents but in smaller
organizations or when a document is less
formal the document Artifact can be a
(c) Sparx Systems 2018
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useful mechanism for storing
information. For example it can be used
to document or plan a stakeholder
workshop or focus group.
Options for
the
Document
Artifact

When a Document Artifact is created
there is an option to use a built-in or user
defined template. Any number of
templates can be created for documents
such as focus groups, workshops surveys
and plans.

Elements and diagrams can be dragged
onto the document from the Project
Browser, which allows readers to click
through from the location in the
document to the diagram or element.
Many of the features found in Word
Processors are available, such as
inserting pictures and tables, creating
(c) Sparx Systems 2018

Page 81 of 275

User Guide - Business Analysis Tools

21 December, 2018

Tables of Contents and headers and
footers, tracking changes to the
document and more.
Learn more Create Document Artifact
about the
Document
Artifact
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Documentation
Getting to know Documentation
Introducing The documentation features can be used
Documentati to automatically generate a wide range of
on documentation directly from the models.
These can be document based such as
PDF and Docx format or html based.
Flexible templates can be used to
completely tailor the documents that are
generated including company logos,
tables of content, tables of element
information and diagrams. Ad-hoc
reports can also be created from a
number of tools such as the Glossary and
the Search Window.

Where to
(c) Sparx Systems 2018
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find
Documentati
on
Use of Modelers, Analysts, Architects, Project
Documentati managers and others can use the facility
on to produce a wide range of document
based publications and reports, such as a:
System Requirements Specification, Use
Case Report, Data Dictionary, Solution
Architecture Description and more. It
can also be used for Ad-hoc reporting to
create reports such as a list of the most
volatile requirements. Html
documentation can also be published to
allow stakeholders who don't have access
to Enterprise Architect to view the
models from an Intranet site that can just
be placed on a file system without the
need for a Web Server.
Options for There are several options that can be set
Documentati to tailor the information that is included
on in a generated document, including the
ordering of elements and diagrams and
hiding certain elements. Filters and word
substitutions and other options can also
be applied.
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Element Appearance
Getting to know Element Appearance
Introducing All elements in the repository have a
Element global default appearance, which is
Appearance defined in the Options Window.
Individual elements can set a global
appearance that overrides the default
setting for all elements and applies to the
specified element wherever it appears in
diagrams. An element's appearance can
also be changed at the level of an
individual diagram by using the color
and font pickers. Images and other
shapes can also be applied to make the
element more appealing.
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Stock Control
Manager

Check Stock
A vailability

21 December, 2018
Business Analysis tool,
element tracing in Sparx
Systems Enterprise
A rchitect
This Custom diagram
shows the relationship
between elements from
different parts of the
Repository. It links a
BPMN Activity with the
stakeholder who owns
the process and the
system that will
ultimately provide the
computational service.

«trace»
Inventory Manager

Manages titles
including
providing services
to add, delete and
modify titles and
advanced sort
and filter services.

Where to Default for all Elements
find Element Ribbon: Start > View > Preferences >
Appearance Standard Colors or Appearance
Global for an element on a diagram
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Context Menu: Appearance | Default
Appearance
Local for a Diagram Object
Ribbon: Layout > Style > Set Font, Text
Color, Fill Color, Line Color, Line Width
Diagram Toolbar (right-click on element
in diagram): Set Font, Text Color, Fill
Color, Line Color, Line Width
Element Icons: Set Font, Text Color, Fill
Color, Line Color, Line Width (top right
corner of diagram object, under
Quicklinker arrow))
Usage of The Element Appearance is useful to
Element convey different meaning to a number of
Appearance audiences and stakeholders. The global
element settings ensure the entire
repository is by default consistent and
these can be changed to suite an
organization. The default element
appearance settings ensure that an
element is consistently represented
whenever it is used on diagrams. The
local appearance settings allow an
element to appear differently on a
specific diagram. Some stakeholders will
also prefer to see an element represented
as an image or by a different shape.
(c) Sparx Systems 2018
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Options for Apart from the setting of Font Style,
Element Text Color, Element Fill and Border
Appearance Color and Line thickness. elements can
be assigned an alternate image or a
completely different geometry using the
Shape Script facility, which is applied to
a stereotype. The images can be assigned
from the
Learn more Set an Element's Default Appearance
about the
TOOL
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Element Browser
Getting to know the Element Browser
Introducing The Element Browser provides a view of
the Element all the important aspects of an element
Browser including Attributes, Operations, Tagged
Values, Files, Internal Requirements,
Relationships, Constraints Maintenance
and Project Maintenance Items and
more. It is a useful window to use in
conjunction with the Project Browser as
it provides all the details of an element
selected in the Project Browser
conveniently collected in a single view.
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Browser
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Ribbon: Design > Element > Properties
> Element Browser
Ribbon: Show > Portals > Window >
Explore > Element Browser
Ribbon: Start > Explore > Browse >
Element Browser

Usage of the The Element Browser can be used to
Element view and to edit all the important aspects
Browser of an element. While the Project Browser
will help the modeler navigate through
(c) Sparx Systems 2018
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and locate elements in the repository, the
Element Browser will allow the element
to be explored in detail.
Options for The Element Browser can be used to
the Element view and edit most of the aspects of an
Browser element. For example, Relationships can
be viewed and deleted, Attributes and
Operations, Constraints, Project
Management and Maintenance items and
more can be viewed and new ones
created. Having the window open while
viewing elements in the Project Browser
will give a simple overview of which
aspects of the element have been
detailed, without the need to expand the
+ indicator to view the details.
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New items can be added to the element
and existing ones deleted directly from
the Element Browser window from the
context menu.
Learn more Element Browser
about the
Element
Browser
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Element Discussions
Getting to know Element Discussions
Introducing The Element Discussions facility allows
the Element modelers to have conversations about
Discussions elements posting discussions and
replying to exiting posts. The discussions
for all elements in the model are
conveniently listed in the Discussions
Review window allowing a modeler to
see all the elements with posts.

Where to To post or view an element's discussion
find Element
Discussions
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To view all discussions in the repository
Usage of Element Discussions allow modelers to
Element have conversations about elements
Discussions without 'polluting' the element's notes
with questions and modeling level
comments such as 'Properties need to be
added before the first release'. This
feature brings the collaborative modeling
platform alive where modelers can add
informal discussions about elements
emulating the discussions held in a
physical workshop.
Options for The Discussion Review window has a
the Element number of options to tailor the
Discussions discussions that are listed including
defining the timeframe allowing older
and perhaps less relevant discussions to
be hidden.

Learn more Informal Discussions
about
Element
Discussions
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Entity Relationship Diagram
Getting to know the Entity Relationship
Diagram
Introducing
the Entity
Relationship
Diagram

The Entity Relationship diagram is a
visual device used to model information
or data and is used as a schema that is a
precursor to database modeling. There
are a number of different representations
that can be used but the style used in
Enterprise Architect uses rectangles to
represent Entities, ellipses to represent
Attributes and diamonds to represent
connections between Entities.
Entity-Relationship Diagrams
Entity Relationship Diagrams in Enterprise Architect are based on Chen's ERD building blocks:
Entities (tables) are represented as rectangles, Attributes (columns) are represented as ellipses
(joined to their entity) and Relationships between the entities are represented as diamond-shape
connectors.
ERD technology in Enterprise Architect assists you in every stage, from building conceptual data
models to generating Data Definition Language (DDL) for the target DBMS.
Entity-Relationship Diagrams are available from the category 'Entity Relationship Diagrams'.

First
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Order
Value

Email
Address

Order
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Order

Customer

Comments

Order
Instructions
La st
Name
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Where to
find the
Entity
Relationship
Diagram

Ribbon: Design > Diagram > Insert >
Entity Relationship Diagram > Entity
Relationship
Project Browser Toolbar : New Diagram
icon > Entity Relationship Diagram >
Entity Relationship
Project Browser context menu | Add
Diagram... > Entity Relationship
Diagram > Entity Relationship

Usage of the
Entity
Relationship
Diagram

They are used by some data modelers as
a way of ensuring independence from the
physical data models that are used to
represent the schema of a given
Relational Database Management
System database. They also provide a
more appealing means of communicating
with non technical stakeholders.

Options for
the Entity
Relationship
Diagram

Entity Relationship diagrams can be
drawn to include all of the Entities in a
given domain in a single diagram or,
alternatively, a number of diagrams can
be created for different aspects of the
domain. Diagram Filters can be used in
presentations to focus on specific parts of
a diagram that are of interest to the
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audience. The Documentation Generator
can also be used to produce a data
dictionary describing the Entities, their
Attributes and their relationships with
other Entities.

The Diagram Toolbox contains a range
of elements, relationships and Patterns
for creating Entity Relationship
diagrams.
The Entity Relationship diagram (like
any diagram) can be viewed as an
element list, which makes working with
the element's properties easier.
Diagram Filters can also be used when
presenting the diagrams to draw attention
to parts of the diagrams, and the
diagrams can be presented as hand drawn
or in a whiteboard style by changing the
properties of the diagram.
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Learn more Entity Relationship Diagram
about the
Entity
Relationship
Diagram
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Flow Chart Diagram
Getting to know the Flow Chart Diagram
Introducing
the Flow
Chart
Diagram
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The Flow Chart Diagram is a strategic
diagram that allows the steps in a
process, workflow or algorithm to be
ordered in a sequence and displayed
graphically. The steps are modeled as
rectangles and choices are modeled as
diamonds, there are inputs and outputs
and data stores available for modeling
the things that are consumed, produced
and stored by the process.
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Flow Chart Diagram
A Flow Chart is a graphical representation of a sequence of events, helping
decision makers understand the relationship between their decisions and a
given outcome. Flow Charts use a range of simple geometric shapes to
represent a process, decision, storage or output.

Flow Chart diagrams are available from the 'Strategic Modeling' category. The
associated toolbox offers a range of elements and connectors that specifically
target that diagram type.

Credit Card Purchase

Transaction
Received
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Retrieve
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Profile

Correct Credit
Card Details
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Card?
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Available?

Provide
Alternate Credit
Card

Product
Inventory

Fulfil Order

Send Customer
Confirmation

Sales
System

Order Fulfilled

Where to Ribbon: Design > Diagram > Insert >
find the Flow Strategic Modeling > Flow Chart
(c) Sparx Systems 2018
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Chart Project Browser Toolbar : New Diagram
Diagram icon > Strategic Modeling > Flow Chart
Project Browser context menu | Add
Diagram... > Strategic Modeling > Flow
Chart
Usage of the The Flow Chart Diagram can be used for
Flow Chart visualizing, analyzing and
Diagram communicating about the steps and
outcomes in workflows, processes and
computer algorithms.
Options for
the Flow
Chart
Diagram
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Flow Chart Diagrams can have nested
Activities allowing hierarchies to be
defined. Responsible parties can be
defined by the use of swim lanes.
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The Flow Chart Diagram (like any
diagram) can be viewed as an element
list which makes working with the
element's properties easier.
Diagram Filters can also be used when
presenting the diagrams to draw attention
to parts of the diagrams and the diagrams
can be presented as hand drawn or in a
whiteboard style by changing the
properties of the diagram.
Learn more Flow Chart Diagram
about the
Flow Chart
Diagram
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Gantt View
Getting to know the Gantt View
Introducing The Gantt View is a tool for visualizing
the Gantt the elements in a Project, Package or
View Diagram and the resources that have
been allocated to them. There are a
number of different Gantt charts
available:
· The Project Gantt View used to view
elements across the entire repository
· Diagram Gantt View used to display
the allocation of resources to the
elements in a given diagram.
· Package Gantt View used to display
the allocation of resources to the
elements contained in a selected
Package.
The tool will empower the traditional or
agile project manager to ensure that a
projects resources are allocated to
repository content and help ensure high
value outcomes are achieved right from
within the repository.
(c) Sparx Systems 2018
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Where to Ribbon: Design > Package > Gantt
find the Ribbon: Design > Diagram > View As >
Gantt View Gantt
Diagram Context Menu: Open Diagram
in | Gantt View
Project Browser Context Menu (on an
open diagram): Open Diagram in | Gantt
View
Usage of the The Gantt View's primary use is to
Gantt View display the allocation of resources to
elements in the repository and to mange
the work breakdown structure. There are
a wide range of views and filters that can
be applied to tailor the view or to make it
(c) Sparx Systems 2018
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more relevant to a particular audience.
Allocations can be made to any elements
in the repository from high level
Packages level down to an individual
element such as a Class, Activity or
Change. It is a powerful tool for a project
managers wanting to visualize how a
team is being utilized and ultimately to
deliver high value and high priority
outcomes. Modelers working on a
project can view their own work and
update their progress while working on
assigned tasks.
While broad changes can be made using
the visual duration bars in the Gantt
View it is common practice to use the
tool in conjunction with the Resource
Allocation window where fine details
can be entered and adjusted.
Options for The Gantt View is a highly flexible tool
the Gantt that can be configured to display
View information in a number of different
ways. Filters can be used to show only
elements that have a particular status or
more generally by using the Filter Bar
and finding elements that contain the
specified filter text in a particular
column. It is also possible to filter the
display by Start or Completion date or to
(c) Sparx Systems 2018
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just show overdue tasks.
Broad changes can be made to the
duration of tasks by simply dragging the
ends of the visual bars. The scale of time
can be altered on the display to allow
short and long term planning and to get
condensed and expanded views.
The Gantt chart can conveniently be
copied to the clipboard and pasted in to
other applications or saved into a file.
There is a wide range of other options
that are available, making the tool
invaluable to a team and schedule-based
approach to modeling.

Learn more Gantt View
(c) Sparx Systems 2018
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about the
Gantt View
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Gap Analysis Matrix
Getting to know the Gap Analysis Matrix
Introducing
the Gap
Analysis
Matrix
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The Gap Analysis Matrix is a specialized
Relationship Matrix that is used to record
the gaps that exist between two versions
of some part of an enterprise. The gaps
between two different versions of an
architecture could be recorded, or the
gaps between two versions of
Capabilities or Staff Competencies, or
two versions of Information or Data. The
tool is structured similarly to a
spreadsheet with columns and rows. The
elements that make up the baseline
(starting point) are listed as columns and
the elements that make up the target (end
point) are listed as rows. There is a
column for recording missing or
eliminated elements and a row for
recording new elements. At the
intersection of a baseline element and
target element, notes can be added that
describe any details of the relationship
between the two elements.
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Where to Ribbon: Design > Impact > Gap Analysis
find the Gap
Analysis
Matrix
Usage of the The Gap Analysis Matrix can be used for
Gap Analysis both business and technical analysis. It is
Matrix a general purpose tool for recording the
details of a comparison between different
versions of some part of an enterprise. In
business analysis it can be used to
analyze Staff Competencies, Data and
Information, Business Processes, Lines
(c) Sparx Systems 2018
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of Business and more, comparing them
between current and future states of an
enterprise. In Enterprise Architecture the
matrix can be used to record gaps
between baseline, transition and target
architectures, comparing Capabilities,
Architecture and Solution Components
and more.
Options for
the Gap
Analysis
Matrix
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The Gap Analysis Matrix can be
configured to display different parts of
the repository. Once the appropriate
Packages have been chosen for the
Target and Baseline, and the types of
elements have been selected for the
filter, the Gap element type can be
selected. The element chosen for the gap
will restrict the available elements to
represent the gap for 'Missing' or 'New'
elements in cells in the matrix. There are
a number of choices available from the
'Options' menu, including being able to
update, delete and save the Gap Analysis
Matrix, giving it a name so that it can be
recalled at a later time.
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Learn more Gap Analysis Matrix
about the
Gap Analysis
Matrix
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Glossary
Getting to know the Glossary
Introducing The Glossary is a project level lexicon of
the Glossary the important terms and their meanings
categorized by type. Any number of
terms, their types and meanings can be
defined and these can be referenced from
the notes of model elements. The terms
can be included in documentation or
generated as a stand-alone report. When
working with domain specific
requirement specifications, architectures
and other models it is essential that new
terms and over-ridden meanings for
common words or phrases are kept in a
suitable dictionary format to ensure
proper understanding of documentation
and specifications.
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Where to
find the
Glossary
Usage of the The project Glossary can be used to
Glossary record the important terms of a project or
domain grouped by the type of term,
allowing business, technical and domain
specific types to be defined. A glossary
report can be generated as a stand alone
report or the glossary can be included as
a section of another document.
Options for The Glossary has a number of options to
the Glossary determine the terms that are displayed in
the list and to define the style that is used
for types of terms in documentation.

Learn more Model Glossary
about the
Glossary
(c) Sparx Systems 2018
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Hand Drawn and Whiteboard Mode
Getting to know Hand Drawn and
Whiteboard Mode
Introducing
Hand Drawn
and
Whiteboard
Mode
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Hand Drawn and Whiteboard Mode are
display options available for any diagram
that changes a system-drawn diagram to
appear as though it was drawn by hand
and, optionally, hand drawn on a
whiteboard. It is a powerful device to
engage an audience by presenting the
diagram in a rough and more immediate
style giving the impression that it is just
a sketch that can be changed.
Both modes will present the diagram in a
hand drawn style but the whiteboard
mode will change the Fill color of the
elements and the diagram background to
white as though it had been drawn on a
whiteboard.
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Where to
find the
Hand Drawn
and
Whiteboard
Mode

Ribbon: Layout > Diagram >
Appearance > White Board Mode or
Hand Drawn Mode
Diagram Context Menu: Properties |
Diagram | White Board Mode or Hand
Drawn

Usage of the
Hand Drawn
and
Whiteboard
Mode

The Hand Drawn diagram mode is a
perfect tool for use in workshops and
presentations to internal or external
customers, as a way of softening the
representation of more formal elements
that are normally displayed in their more
rigid geometric forms. Audiences will
tend to respond to the diagrams more
favorably as they appear to be just
sketches and not yet resolved as finished
diagrams. Stakeholders who are not
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familiar with the formal modeling
languages such as UML will typically be
more engaged by these diagrams.
The Whiteboard mode will give the
appearance that the diagram was
sketched on the whiteboard, again adding
an immediacy to the drawing.
Both the Whiteboard and Hand Drawn
modes of presentation can be carried
through to generated documentation that
contains the diagram.
Options for
the Hand
Drawn and
Whiteboard
Mode

The Whiteboard mode will give the
appearance that the diagram was
sketched on the whiteboard again adding
an immediacy to the drawing.
Both the Whiteboard Hand Drawn mode
of presentation can be carried through to
generated documentation that contains
the diagram.

Learn more Hand Drawn and Whiteboard Mode
about the
Hand Drawn
and
Whiteboard
Mode
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Image Manager
Getting to know the Image Manager
Introducing The Image Manager is used to manage
the Image pictures in the Repository, allowing them
Manager to be maintained and reused across
diagrams. Images can be inserted in a
variety of formats including Bitmaps and
Extended Windows Metafiles are then
used to change the conventional
appearance of elements to create more
appealing and compelling diagrams.
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Where to Defining Images
find the Ribbon: Configure | Reference Data |
Image Images
Manager
Using Images
On diagram, right-click element |
Appearance | Select Alternate Image
Usage of the The Image Manager's main use is to
Image define pictures that can be used as
Manager alternate representation for elements in
diagrams. For many business and
networking diagrams the default
appearance of an element such as a UML
Class or Component can be replaced
with an image from the Image Manager
making the diagram more appealing to
its audience. The Image Manager will
also store images that are defined in
included technologies.
Options for The Image Manager allows Images to be
the Image imported in a variety of formats
Manager including Bitmaps and Extended
Windows Metafiles. Images can be
imported from the file system or
conveniently from the Clipboard.
(c) Sparx Systems 2018
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There is also an option to display the
diagrams where the image has been used.
Learn more Image Manager
about the
Image
Manager

(c) Sparx Systems 2018

Page 123 of 275

User Guide - Business Analysis Tools

21 December, 2018

Import and Export Spreadsheets
Import and Export Spreadsheets
Introducing
Import and
Export
Spreadsheets
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This facility is a useful mechanism to
import Requirements that have been
defined in a Spreadsheet or a Word
Processor table into Enterprise Architect.
Once in Enterprise Architect the
Requirements can be managed and
traced to elements such as business
drivers and Scenarios and Components.
Alternatively Requirements in Enterprise
Architect can be exported to a
Spreadsheet for the purposes of
providing them to a third party or for
some type of numerical or statistical
analysis. The mapping between fields in
the Spreadsheet and the analogous
properties in Enterprise Architect is
completely configurable using a
specification.
For more detailed information exchange,
the Microsoft Office Add-In (available
from Sparx Systems) provides additional
functionality and integration points
useful when dealing with complex
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Requirements.

Where to
find Import
and Export
Spreadsheets
Use of
Import and
Export
Spreadsheets

This feature can be used to import or
export Requirements from a CSV file.
Before a tool like Enterprise Architect is
installed analysts might have used a
Spreadsheet or a table in their favorite
word processor to record requirements;
these can conveniently be imported using
the CSV import facility. Alternatively,
Requirements sometimes have to be
provided to a third party who will
typically specify that they want them in a
Spreadsheet file; this can be achieved
using the export facility.

Options to The import and export facility is
(c) Sparx Systems 2018
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Import and completely configurable and has a user
Export defined specification that can be used to
Spreadsheets determine how fields in the Spreadsheet
file are mapped to Requirements
properties in Enterprise Architect
including being able to import and export
fields to and from Tagged Values of the
Requirement.
Learn more CSV Import and Export
about Import
and Export
Spreadsheets
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Info View
Getting to know the Info View
Introducing The Info View is an alternative
the Info View representation for an element that is
typically more appealing to managers or
non-technical stakeholders. The Info
View displays the name, stereotype,
notes and a small icon that represents the
shape of the element. Other element
properties can be displayed by using the
'Visible Properties' dialog.

(c) Sparx Systems 2018
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Where to Element Context Menu: Info View |
find the Info Enabled
View Element Context Menu: Info View |
Visible Properties
Usage of the The Info View is a useful alternative
Info View representation of an element in a diagram
which is often appealing to managers and
high level stakeholders. The Info View
will show the name of the element, a
small Icon that signifies the type of
element, additional properties and the
element's notes. It is useful in situations
where the audience of the diagram does
not need to know about the details such
(c) Sparx Systems 2018
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as Attributes, Operations, Database
Columns, and other details.
Options for The properties that are displayed by the
the Info View Info View representation can be
configured to make the element more
meaningful to particular audiences. The
'Visible Properties' dialog allows
properties to be selected for display.

A portion of the notes will be displayed
using the available space in the Info
View; if all the notes need to be
displayed the diagram element can be
resized to provide space for the text.
Learn more Info View
about the
Info View
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Insert Related Elements
Getting to know Insert Related Elements
Introducing
Insert
Related
Elements

(c) Sparx Systems 2018

Insert Related Elements is a powerful
productivity and exploration tool that
allows diagrams to be created
automatically from relationships that
exist in the repository. Typically
elements are added to the repository by a
number of modelers and no single person
will be totally aware of all the elements
in the repository and their relationships.
By placing a single element onto a
diagram that acts as a context (or starting
point) the Insert Related Elements
facility can be used to explore the
element's connections and to
automatically draw a diagram using the
context element as a starting point. This
will almost seem like magic and
powerful and expressive diagrams can be
created that a modeler will not have seen
before or not thought of creating.
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Related
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Usage of
Insert
Related
Elements
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Ribbon: Design > Element > Insert >
Insert Related Elements
On diagram, right-click on element |
Insert Related Elements
The Insert Related Elements facility can
be used to create a diagram automatically
from its relationships in the repository,
including the relations of the related
elements themselves down to a deeper
level. It can also be used as a discovery
tool where the modeler wants to explore
a model (or part of a model) they might
not be familiar with. It is also useful in
workshops when a number of model
authors or other stakeholders are present
to show the traceability between
different parts of a repository.
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Insert Related Elements has a flexible
interface that allows the modeler to
configure what types of relationship to
include in the discovery, the direction of
those relationships, the types of related
elements to be included, the depth of the
graph traversal and more. The related
elements can be related to a specified
namespace, and once a set of related
elements has been listed the modeler can
choose which elements to insert into the
diagram. A depth of 1 will just include
the elements directly related to the
context element, a depth of 2 will include
the directly related elements and any
elements directly related to them, and so
on up to a depth of 5.

Page 133 of 275

User Guide - Business Analysis Tools

21 December, 2018

There is also the option to allow the tool
to layout the diagram after the elements
have been inserted.
Learn more Insert Related Elements
about Insert
Related
Elements
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List View
Getting to know the List View
Introducing The List View is a powerful tool for
the List View viewing the contents of a Package or a
diagram as a list of elements, allowing
the elements' properties to be viewed and
edited in a convenient spreadsheet-like
view. Many analysts will prefer to view
elements in a list, and when details are
changed the changes will be effective in
every other view of the element,
including diagrams and the Project
Browser.
There are a number of options for
filtering, sorting and grouping elements
in the list based on a wide range of
properties and Tagged Values.
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Where to Ribbon: Design > Package > List
find the List Ribbon: Design > Diagram > View As >
View List
Diagram Context Menu: Open Diagram
in | List View
Project Browser Package Context Menu:
Open Package in | List View
Project Browser Diagram Context Menu
(on an open diagram): Open Diagram in |
List View
Usage of the The List View can be used to get a
List View different view of the elements contained
in a Package or a diagram and to
visualize their properties in a single
spreadsheet-like view. It is particularly
useful when dealing with non technical
(c) Sparx Systems 2018
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audiences or when the elements need to
be sorted, filtered or grouped based on
criteria such as Name, Status, Phase,
Version and more. Project Managers and
others working with sets of elements will
be able to analyze in a given Package or
diagram. There is also a related Gantt
View where resource allocations, work
completion and timings can be
visualized.
Options for Additional properties can be added by
the List View using the 'Field Chooser' dialog and
Tagged Value columns can also be
added, allowing a modeler to view the
elements' native properties and Tagged
Values side-by-side. The elements in the
list can also be exported to a document
report using any number of built-in or
user defined templates and generating to
a variety of formats including Docx,
PDF and RTF.

(c) Sparx Systems 2018

Page 137 of 275

User Guide - Business Analysis Tools

21 December, 2018

Learn more List View
about the
List View
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Maintenance Items
Getting to know Maintenance Items
Introducing Element Maintenance Items can be used
Maintenance with any element, including
Items Requirements, Components, Classes and
other elements to capture problems,
changes, issues, tasks, events and
decisions that affect an individual
element. Using maintenance items to
track official changes, additions and
deletions to sets of Requirements,
Components, User Stories and other
specifications provides a sound basis for
overall project governance and
traceability.
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Where to Ribbon: Construct > Change
find Management > Changes | Defects |
Maintenance Issues | Tasks | Events | Decisions
Items
Usage of Element Maintenance Items can be used
Maintenance to record a wide range of information
Items about elements including: changes,
issues and tasks and more. These can be
used to track the way an element is
altered and maintained and can provide
information about the Item including the
rationale for the alteration, status and
priority. While the Baseline and Auditing
features record what has changed
automatically the Maintenance Items
provide the flexibility for a modeler to
specify details manually.
Options for There are a range of maintenance items
Maintenance that can be used to add information to
Items elements these include: Defects,
Changes, Issues, Tasks, Decisions and
Events. Items can have information such
as who requested the item, who
completed the item and status and
priority.
Learn more Maintenance Items
about
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Maintenance
Items
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Mind Mapping Diagram
Getting to know the Mind Mapping Diagram
Introducing
the Mind
Mapping
Diagram

The Mind Mapping Diagram is a useful
tool for recording ideas, thoughts and
information in a simple and
understandable format. The diagram is a
type of spider (or radial) diagram where
a Central Topic or idea is typically
located at the centre of the diagram and
Main Topic, Topic and Sub-Topics
radiate out as the ideas are explored and
recorded.
Customer Added Value
Workshop

Free delivery for
volume
purchases

Season aware
gift wrapping

Delivery

Hardback and
softback options

Inventory
Virtual Titles

Super Express
international
delivery
Customer Value
New edition
alert service

Drop-down lists
User and
editorial
reviews
Map interface
for parcel
location

Ease of Use

Extra Services
Online user
library

Portable device
App
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This Mind Mapping diagram shows the use of
central topics, Main topics, and topics to
organize thoughts priority can be indicated
using the order of elements in the Project
Browser.

Buy back service
for new titles

Page 142 of 275

User Guide - Business Analysis Tools

21 December, 2018

An analyst will often be required to take
notes or record ideas (including their
own) and information in the context of
meetings, workshops and focus groups.
The Mind Mapping diagram is a useful
tool and its simple and appealing layout
makes it accessible to everyone.
Regardless of what formal languages or
frameworks are being used to articulate
requirements and processes and other
artifacts the Mind Mapping diagram
requires little or no explanation.
Where to
find the
Mind
Mapping
Diagram

Ribbon: Design > Diagram > Insert >
Mind Mapping > MindMapping Diagram
Project Browser Toolbar : New Diagram
icon > Mind Mapping > MindMapping
Diagram
Project Browser context menu | Add
Diagram... > Mind Mapping >
MindMapping Diagram

Usage of the
Mind
Mapping
Diagram

A MindMapping Diagram can be used to
record ideas and information in the
context of a workshop, focus group,
meeting or even to get your own
thoughts down. It becomes a compelling
visual record of the communication and
discussions and often acts as a precursor
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to more formal techniques such as
requirements articulation, Architecture
modeling database design and more.
Requirements and other elements such as
Capabilities, Acceptance Criteria, design
Components, User Stories and more can
all be traced back to Topics and
Sub-Topics in a MindMapping Diagram.
Options for
the Mind
Mapping
Diagram
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A MindMapping diagram can be made
more expressive with the use of images
and colors. The appearance of the
Central Topic and Main topics could use
an image that visually communicates the
central idea. Colors can be applied to
communicate concepts such as the
importance or the owner of an idea or
any other concept. Dependency
relationships can be added to show how
ideas relate to each other; for example,
which stakeholders have specific
interactions or which services depend on
other services.
The MindMapping Diagram (like any
diagram) can be viewed as an element
list which makes working with the
element's properties easier.
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Diagram Filters can also be used when
presenting the diagrams, to draw
attention to parts of the diagrams. The
diagrams can be presented as hand drawn
or in a whiteboard style by changing the
properties of the diagram.
Learn more Mind Mapping Diagram
about the
Mind
Mapping
Diagram
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Model Mail
Getting to know the Model Mail
Introducing Model Mail is a mail system internal to
the Model the Enterprise Architect repository that
Mail allows users to send and receive mail
messages. One of the important
advantages that Model Mail has over
other mail systems is that it is possible to
embed hyperlinks to parts of the
repository, allowing the recipient to click
through to the diagrams, matrices,
elements, Packages, reviews and more.

(c) Sparx Systems 2018

Page 146 of 275

User Guide - Business Analysis Tools

21 December, 2018

Most initiatives are carried out by a team
of people, and critical to their success is
good communication. With a fully
featured tool such as Enterprise
Architect, it is typical for team members
to perform a lot of their work inside the
tool; having mail internal to the
repository provides a lot of advantages.
The Model Mail facility allows team
members and others using Enterprise
Architect to send and receive mail
messages including hyperlinks to
repository content.
(c) Sparx Systems 2018
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Where to Ribbon: Start > Collaborate > Mail
find the
Model Mail
Usage of the Model Mail can be used to send and
Model Mail receive mail messages internal to the
model allowing team members and other
stakeholders to communicate effectively
about the model and its content. A
typical scenario might be a team member
sending a message with a link to a set of
Requirements to a number of people
asking for their comments.
Options for Model Mail has the option to insert links
the Model to a variety of repository items including:
Mail Diagrams, Matrices, Images, Searches,
Help Topics, Attributes, Operations,
Team Library and more.

Learn more Model Mail
about the
Model Mail
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Model Search
Getting to know Model Search
Introducing The Model Search facility is a powerful
Model and flexible tool for finding anything in
Search the modeling repository. An object can
be located regardless of what a user is
looking for, whether it is the name of an
element, text in element notes, a Tagged
Value or properties such as when an
element was created, who created it,
what its status is, and more. The facility
includes a wide range of built-in searches
that can be used or a user can define their
own searches using the Query Builder,
SQL Builder or by defining an Add-In
Search.
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With a number of analysts and others
working on creating or importing content
into the repository the number of
elements will increase rapidly and before
long even with a well organized model it
will not be possible to remember where
all the elements are located. The search
facility can be used to locate information
easily no matter where it is in the model.
Where to Ribbon: Start > Explore > Search >
find Model Model
Search Ribbon: Design > Element > Edit >
Search Model
Usage of The Model Search facility can be used to
Model find anything that exists in the
Search repository. It can be used to return a set
of elements that meet specified criteria
for example in preparation for an
(c) Sparx Systems 2018
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iteration to get the list of all
Requirements that were created in the
last two weeks that have a Status of
Validated and that have a Difficulty
value of Low and a Priority of High. The
result set can be sorted, documentation
can be generated and individual elements
can be Book Marked, or located in the
Project Browser or in all the diagrams in
which they appear.
Searches can be used as the basis of a
number of other tools such as Model
Views, the Documentation Generator
and more.
Options for A user can choose to use predefined
Model searches or create their own user-defined
Search searches. Searches can be defined using
three different tools: the Query Builder,
which is screen driven and easy for most
non-technical analysts to understand; the
SQL Builder, which uses SQL; or
creating an Add-In Search, which
requires some programming.
The Query Builder is the most intuitive
of the tools and allows a user to build up
their own query adding one or more
filters to restrict the set of elements that
will be returned.
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The Search Facility can be configured to
query a single Package (and its
sub-Packages if required) or to search the
entire Repository.

Elements returned in the search results
list can also be exported to a word
processor or Spreadsheet document.
Learn more Model Search
about Model
Search
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Model Transformation
Getting to know the Model Transformation
Introducing
Model
Transformati
on
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Model Transformations are a
productivity tool that allow models to be
manipulated to create more specialized
or resolved models. The transformations
can be applied to produce a variety of
output models including logical and
physical data models, XML Schema
models, programming languages and
more. The Model Driven Architecture
(MDA) transformations use a flexible
and fully configurable template system.
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Where to Ribbon: Design > Tools > Transform >
find Model Transform Selection
Transformati
on
Usage of
Model
Transformati
on

Model Transformations can be used as a
productivity tool to transform a primitive
model to a more resolved model. There
is a wide range of built-in
transformations, including:
· Generating from a Class model to a
programming language model,
including C++, C#, PHP, Java and
many more
· Generating from a Class model to a
data model, including ERD, Oracle,
SQL Server, XSD and WSDL models
· Generating from a Class model to a
test model, including NUnit and JUnit
test models and more

Options for
Model
Transformati
on

Model Transformations are completely
configurable using a powerful, simple
and flexible template system. This
includes the flexibility to create new user
defined transformations and modify or
extend existing ones.
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Learn more Model Transformation
about Model
Transformati
on
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Model Views
Getting to know Model Views
Introducing Model Views provide an alternative view
Model Views of the elements in the Repository.
Whereas the Project Browser is designed
to organize the Packages and elements
structurally, the Model Views facility
allows the modeler to create a number of
views that can group elements and
diagrams differently.
The Project Browser has been designed
to organize the elements structurally,
grouping elements and diagrams together
into Packages based on factors such as
namespaces, type of element and the part
of the process. Model Views allow a user
to create a structure based on a wide
range of criteria including Favorites
folders and folders based on a search
such as all elements I created last week
that have a status of 'Proposed'.
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Where to Ribbon: Show > Portals > Window >
find Model Explore > Model Views
Views Ribbon: Start > Explore > Browse >
Model Views
Usage of Model views can be created for a variety
Model Views of purposes and an experienced modeler
will often use the Model Views facility
as the access point to the Repository. The
Favorites folder is useful to keep track of
hand picked elements and diagrams of
interest. The Slide show folder is useful
to create a diagram slide show for the
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purposes of demonstrating diagrams to a
group of people in a workshop or
meeting. The Search folder is useful to
keep track of elements that meet
specified criteria and to be notified when
new elements are added to the
Repository that meet the criteria.
Options for The Model Views root folder defines
Model Views views that every user can see, whereas
the My Views root folder is only visible
to the current user. Both these root
folders can contain any number of
user-defined folders down to two levels.
User-defined folders under the Model
Views folder can contain three types of
view: Favorites, Diagram Slide Shows
and views based on a Search.
User-defined folders under the My View
folders can contain only views based on
a Search.

The Model Views window provides a
convenient toolbar for working with the
folders and elements.
Learn more Model Views
(c) Sparx Systems 2018
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about Model
Views
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Organizational Chart Diagram
Getting to know the Organizational Chart
Diagram
Introducing
the
Organization
al Chart
Diagram
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An organizational model is a powerful
tool that is a visual representation that
describes the roles, responsibilities and
the reporting structure of an
organization. It is invaluable to a
Business Analyst as it allows them to
visualize and to understand who they
need to communicate with while
performing various tasks. The
Organization Chart in Enterprise
Architect is flexible and can be used to
create any type of representation
including the inclusion of images
representing teams or individuals.
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Business Analysis Organization Chart in Sparx Systems Enterprise
A rchitect.
This Organization Chart diagram shows how the organizational structure
of an organization can be represented graphically. Tree Vertical and
Lateral Vertical line styles have been used to lay out the diagram.

Where to
find the
Organization
al Chart
Diagram

Ribbon: Design > Diagram > Insert >
Strategic Modeling > Org Chart
Project Browser Toolbar : New Diagram
icon > Strategic Modeling > Org Chart
Project Browser context menu | Add
Diagram... > Strategic Modeling > Org
Chart

Usage of the
Organization
al Chart
Diagram

The Organizational Chart can be used to
create any type of chart, including a
Functionally Orientated, Market
Orientated or Matrix Model chart. A
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number of charts could be created,
representing different current and future
states of the enterprise.
Options for
the
Organization
al Chart
Diagram

Apart from the relationships that
represent reporting lines in the
Organizational Chart, Business Analysts
can also add relationships of authority,
influence, and communication, which
might not overlay the reporting lines.
These additional lines can be modeled
using named Associations and
stereotyped if required.

The Organizational Chart (like any
diagram) can be viewed as an element
list, which makes working with the
element's properties easier.
Diagram Filters can also be used when
presenting the diagrams, to draw
attention to parts of the diagrams; the
(c) Sparx Systems 2018
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diagrams can be presented as hand drawn
or in a whiteboard style by changing the
properties of the diagram.

Learn more Organizational Chart
about the
Organization
al Chart
Diagram
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Package Browser
Getting to know the Package Browser
Introducing The Package Browser is a powerful tool
the Package that provides a convenient list of the
Browser elements in a Package displayed in a List
or a Gantt view. The List view allows a
modeler to work on the elements in the
Package in a spreadsheet-like view,
editing properties and notes inline and
grouping and sorting the elements. The
Gantt Chart view allows analysts,
architects, project managers and others to
view the resource allocation for an
element in a convenient and familiar
time based view.
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Where to Select the Package in a diagram or the
find the Project Browser
Package
Browser Ribbon: Design > Package > List
Context Menu in diagram: Open Package
in | List View
Project Browser Context Menu: Open
Package in | List View
Usage of the The Package Browser provides a
Package convenient and alternate view of the
Browser elements in a Package. The list view can
be used as a workbench for viewing the
elements in user defined order, changing
the elements properties and adding and
deleting elements. The ability to display
the elements grouped by various
(c) Sparx Systems 2018
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properties and Tagged Values allows
analysis to be performed on groups of
elements. The Gantt chart view provides
a project management view of the
elements showing how resources are
allocated to individual elements. Reports
for all, or a selected group of elements
can be generated.
Options for The Package Browser has two different
the Package formats or display options: a User
Browser Defined view and a Hierarchy view. The
User Defined view displays all the
elements in the Package regardless of
hierarchy. The Hierarchy view arranges
the elements in accordance with the way
they are grouped in the Project Browser.
In the User Defined view the items can
be sorted in ascending or descending
order by clicking in the column headers.
The order of columns can be changed by
dragging column headers left or right. A
modeler can drag column headers onto
the View Header (above the column
headers), which will group the items in
the list by that property; column headers
can be nested in a hierarchy to specify
groups within groups.
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Learn more Package Browser
about the
Package
Browser
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Pan and Zoom
Getting to know Pan and Zoom
Introducing The Pan and Zoom window is one of the
Pan and tools that can be used to navigate around
Zoom a large diagram. Often, the resolution of
a diagram must be reduced to ensure it is
wholly visible, but by using the Pan and
Zoom window you can leave the diagram
at a readable resolution and pan around
to areas of interest, zooming in when
necessary.

Many initiatives will be best described
(c) Sparx Systems 2018
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by a number of large diagrams, ranging
from A3 - A0. Even when you are
fortunate enough to be using a large
monitor, you will want to change the
scale at which you are viewing the
diagram and then pan around to find the
section or element of interest in the
diagram, and then zoom into that section.
The Pan and Zoom window will allow
you to do this for any size diagram, with
tools for panning and zooming that are
particularly useful during workshops or
focus groups.
Where to Ribbon: Layout > Tools > Pan and Zoom
find Pan and (Ctrl+Shift+N)
Zoom
Usage of Pan The Pan and Zoom window can be used
and Zoom for moving around and zooming into
large diagrams. A typical scenario could
be that an Analyst has created a diagram
showing traceability from Solution
Components back through detailed
Requirements and User Stories and
Processes up to the level of Business
Goals. This diagram would typically be
too large to view at the right resolution
even on a large monitor. The Pan and
Zoom window could be used to set the
(c) Sparx Systems 2018
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diagram resolution to a scale that could
be easily read and then to pan around the
diagram to elements and areas of
interest, zooming in and out as required.
Options for The Pan and Zoom window has a
the Pan and number of options:
Zoom · You can pan across the diagram using
your mouse pointer to drag the colored
rectangle around to different sections
of the diagram
· You can zoom into and out of the
diagram either using the Slider control
to change the scale of the diagram, or
using the tool icons to:
- Zoom In
- Zoom Out
- Zoom to fit diagram
- Zoom to fit page
- Zoom to 100%

Learn more Pan and Zoom
about Pan
and Zoom
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Project Browser
Getting to know the Project Browser
Introducing The Project Browser is the primary tool
the Project for structuring and navigating through
Browser the repository using expanding and
collapsing tree nodes. The key structural
element is the Package, which is a
folder-like element that can contain other
elements and diagrams, and other
Packages. The elements in turn can
contain other elements, features and
diagrams. Root nodes are the highest
nodes in the tree and these root Packages
can contain views that in turn can
contain any level of Packages and
elements. Tree nodes including
Packages, elements, Features and
diagrams can be copied and pasted
between locations or dragged and
dropped to new locations. Many
important tools, functions and windows
are applied at the level of the Package,
such as import or export of model
content, documentation and Package
Control, including Baselines.
(c) Sparx Systems 2018
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Ribbon: Show > Portals > Window >
Explore > Project Browser
Ribbon: Start > Explore > Browse >
Project Browser

Usage of the The Project Browser can be used to
Project create and manage the structure of the
Browser repository by adding and deleting,
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moving and copying Packages, elements,
Features and diagrams. It is often the
primary tool for exploring and browsing
through the elements in the repository
and finding things of interest. A modeler
working with an open diagram will often
want to locate a diagram object in the
Project Browser as a way of finding out
what Package it belongs to and what its
peers are.
Options for The Project Browser has a context menu
the Project that contains the import functions that
Browser apply to each of the selected element
types. Many of the functions are also
available in the Project Browser Toolbar
positioned at the top of the window. This
includes the ability to create Packages,
diagrams, elements and documentation.
The Project Browser itself can be moved
around the workspace as required.

There are also several important ways
the Project Browser can be configured by
using the 'Preferences' dialog. These
include the ability to Show or Hide
stereotypes in the name of a tree node,
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the ability to freely sort the tree nodes
within a Package or element and whether
to warn about deletions from the tree.
There is also the ability to configure the
action that occurs when a node in the tree
is double-clicked.
Learn more Project Browser
about the
Project
Browser
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Project Management Items
Getting to know Project Management Items
Introducing
Project
Management
Items

Project Management Items allow a
modeler to define useful information
about an element from the perspective of
the management of the element. These
include the Resources that can be
allocated to work on the element, the
Effort required to complete work on the
element, Metrics that capture valuable
information about a property of the
element, and Risks associated with the
element.

Where to
find Project
Management
Items

Ribbon: Construct > Task Management
> Resource Allocation
Ribbon: Construct > Change
Management > Effort, Risks, Metrics
Element Browser: | Project Management
| Resource Allocation, Effort, Risks,
Metrics

Usage of Project Management Items can be added
Project to assist in the management of a project.
Management Specifying the resources that can be
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Items allocated to work on a particular element
will assist with ensuring the right
resources can be scheduled to carry out
the work. The Effort required will also
help in specifying exactly what resources
will be required. The Metrics can
provide useful and structured
information about properties of the
element such as the cost and time
estimations. Risks can be defined that
will assist in the overall management of
project risks.
Options for
Project
Management
Items

Project Management Items can be
applied to any element in the Repository,
including Packages, which is useful if a
manager wants to assign an item such as
Resource Allocation to a number of
elements such as a group of Non
Functional Requirements.

There is a convenient toolbar that allows
you to manage any of the Project
Management Items, with icons for New
(Item), Save, Delete, Sort and more.
Learn more Project Management Items
(c) Sparx Systems 2018
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about
Project
Management
Items
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Relationship Matrix
Getting to Know the Relationship Matrix
Introducing
the
Relationship
Matrix

(c) Sparx Systems 2018

The Relationship Matrix is a tool for
visualizing the way that requirements are
related to each other and to other
elements in the model in a visually
compelling matrix or spreadsheet like
view. It can be used to view the
relationship between Stakeholders and
their Requirements, how Use Cases are
related to Business Requirements or
Functional Requirements, how
Capabilities are related to Business
Drivers, which Components implement a
set of requirements, and more. Any
number of matrices can be defined
quickly and then saved to be viewed in
workshops or included in documentation
generated automatically from the model
or exported to a spreadsheet file. When a
matrix is created, connections can be
viewed by placing the Requirements on
one axis of the matrix and the connected
elements on the other axis, then the cells
of the matrix will indicate the direction
Page 178 of 275

User Guide - Business Analysis Tools

21 December, 2018

of the relationship.

Where to
find the
Relationship
Matrix

Project Browser Context Menu
(Package): Relationship Matrix | As
Source.../As Target.../As Both...
Resources Window: Matrix Profiles

Usage of the To display the relationships that exist
Relationship between elements - such as which
Matrix Requirements are realized by which Use
Cases - in two Packages in a visually
compelling matrix. It is useful in
analyzing missing elements or
relationships; for example, to determine
which Requirements are not realized by
any Use Case, or which Components do
not have corresponding Requirements or
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Use Cases. It is particularly useful in
workshops with Business Stakeholders
who might not be familiar with seeing
Requirements in Trace diagrams.
Options for
the
Relationship
Matrix

There are a range of options that can be
set for the matrix including saving it to
the Resources window or to a CSV
format for opening in a spreadsheet. The
appearance of the matrix can also be
altered by sorting the elements, showing
an outline numbering view, and
suppressing Package names. These items
are available from the Options button on
the Relationship Matrix.

Learn more Relationship Matrix
about the
Relationship
Matrix
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Requirement Properties
Getting to Know the Requirement Properties
Introducing Requirement Properties are used to
Requirement define metadata about the requirement
Properties that is useful for the management of
requirements for the purpose of
prioritization and defining work
Packages for the implementation teams.
All Enterprise Architect elements have
standard properties such as Status,
Author and Phase but the Requirement
element has additional properties such as
Difficulty and Priority. User defined
properties can also be defined using
Tagged Values.
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Ribbon: Design > Element > Properties
> Properties
Element Context Menu: Properties... |
Properties...
or
Project Browser Context Menu:
Properties | Properties...

Usage of the To define the important meta information
Requirement about a requirement, for the purposes of
Properties providing data to manage the
requirements for prioritization,
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understanding which are the difficult
requirements, and managing the lifecycle
by using Status to determine
requirements for implementation
Packages.
Options for Enterprise Architect has a wide range of
Requirement built in properties for all elements but it
Properties has a number of additional properties for
requirements. If there are other
properties that are needed by a modeler
or team such as the volatility (stability)
of a requirement these can be added
using the general purpose UML
extension mechanism of Tagged Values.

Learn more Properties Dialog
about
Requirement
Properties
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Requirements Checklist
Getting to know the Requirements Checklist
Introducing
the
Requirement
s Checklist

The Requirement Checklist is a
convenient element that acts as a tally to
indicate whether a Requirement complies
with a set of predefined measures such as
whether the Requirement is Atomic,
Cohesive, Traceable and Verifiable. It
can be assigned to any Requirement and
the measures can be updated directly in
the diagram. When working with
requirements it is sometimes very useful
to refer to a common set of 'best
practices' and qualities that help define
the nature of a well formed specification.
The Requirement Checklist element is
designed to meet this need.
REQ117 - The system must
provide a mechanism
allowing students to
identify themselves

(c) Sparx Systems 2018

Requirements Checklist
Atomic
A tt ainable
Cohesive
Complete
Current
Independent
M odifiable
Traceable
Unam biguous
V erifiable

This diagram shows the use of
a Requirements Checklist that
acts as an indicator (check) to
ensure the requirement is
compliant with best practice.
The check items are editable
and a general checklist
element is available that can
be used with any element.
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Where to Toolbox : to display the 'Find
find the Toolbox Item' dialog and specify
Requirement 'Requirements Checklist'
s Checklist
Usage of the Analysts and Requirements Managers
Requirement can use the checklist to annotate whether
s Checklist one or more requirements meet a set of
predefined checks.
Options for
the
Requirement
s Checklist

The list of measures is completely
configurable and items can be added or
removed from the list for each individual
checklist by using the Checklist Tagged
Value notes.

Learn more Requirements Checklist
about the
Requirement
s Checklist
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Requirements Diagram
Getting to Know the Requirements Diagram
Introducing
the
Requirement
s Diagram

(c) Sparx Systems 2018

The Requirements diagram provides a
visual representation of how
Requirements are related to each other
and to other elements in the model,
including Business Drivers, Constraints,
Business Rules, Use Cases, User Stories,
design Components and more. The
diagram is one of Enterprise Architect's
extended diagram types and for analysts
who are accustomed to working with
requirements in a text based tool it will
provide a welcomed and compelling
graphical representation of the
requirements.
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Books
A book storage and
management facility will be
required.
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This diagram shows a Use Case
that realizes a requirement. The
realized requirement is part of a
hierarchy of requirements
expressed with the Aggregation
relationship. The Use Case has
an annotation under the
element indicating its package
location in the Project Browser.

REQ027 - Add Books
A facility will be required to
receive and add books to the
stock lists.

«realize»

Add New Titles

(from Manage Inventory)

Where to Project Browser Context Menu : Add
find the Diagram :
| Manage | Show All
Requirement Perspectives | Extended | Requirements
s Diagram
Usage of the One usage is to show how Requirements
Requirement are connected together in a hierarchy, but
s Diagram a more compelling usage is to show how
requirements are connected to other
elements. The experienced modeler will
define and manage the requirements in
the Specification Manager and then use
the Requirements diagram to show how
one or more requirements are related to
up-process elements such as Business
Drivers and down-process elements such
as Use Cases, User Stories, User
(c) Sparx Systems 2018
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Experience designs and solution
Components.
Options for
the
Requirement
s Diagram

The appearance of a diagram can be
changed to suit the audience, and details
can be included, suppressed or altered to
ensure the diagram meets its main
objective of communication. There is a
wide range of options, ranging from
creating a Hand Drawn style of diagram
to page set up.

Learn more Working In Diagrams
about the
Requirement
s Diagram
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Page 189 of 275

User Guide - Business Analysis Tools

21 December, 2018

Risk Taxonomy
Getting to know the Risk Taxonomy
Introducing The Risk Taxonomy is a facility to
the Risk define a comprehensive, stable and
Taxonomy reusable set of risk categories that can be
applied universally across the system.
This includes definitions of Threats, Loss
type, Contact Frequency, Loss
Magnitude, Risks and more. It is based
on the Open Group Standard for Risk
Taxonomy (OR-T) and provides a
toolbox and diagrams for defining the
Taxonomy.
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Risk Taxonomy
The UML Profile for Risk Taxonomy provides support for modeling risk scenarios
and analyzing risk conditions.
The Risk Taxonomy profile provided by Enterprise Architect supports the Open Group
Standard for Risk Taxonomy (OR-T), version 2.0.

Risk Taxonomy diagrams and their associated toolboxes are available from the
Risk Taxonomy category.

«Risk Scenario»
User Name and Password
left on Sticky Note by
Warehouse Manager

«ThreatCommunity»
Contract Couriers

«ThreatEventFrequency»
High
Based on the fact that the
contractors access the warehouse
more than 360 times a year (more
than once daily) and they know the
value of using the credentials to
access computers to determine
valuable stock locations.

«ThreatCapability»
Medium
The couriers only need
to have the capacity to
read the written text
on the sticky note and
to realize that they are
credentials.

Risk Taxonomy and Risk Analysis
diagram in Sparx Systems
Enterprise Architect
This Risk Taxonomy Diagram
shows the use of elements to
model risk in a formal way
including the Risk Scenario,
Threat Communities, the
frequency of the threat, the Threat
Community's capability and the
strength of the controls.
Vulnerability can then be derived
from these other factors.

«ResistanceStrength»
Very Low
The credentials are
written in clear text in
an unencrypted way
and so there is little
control strength.

«Vulnerability»
Very High

Where to Ribbon: Design > Diagram > Insert >
find the Risk Risk Taxonomy > Risk Taxonomy
Taxonomy Project Browser Toolbar : New Diagram
icon > Risk Taxonomy > Risk
Taxonomy
Project Browser context menu | Add
Diagram... > Risk Taxonomy > Risk
Taxonomy
Usage of the The Risk Taxonomy provides a common
Risk language and references for security and
Taxonomy business analysts who need to
understand and analyze risk in a formal
way. It allows analysts to estimate the
probable frequency and magnitude of
(c) Sparx Systems 2018
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future loss.
Options for The Risk Taxonomy can be used at
the Risk varying levels of formality depending on
Taxonomy the initiatives, processes and
requirements for risk assessment. The
Relationship Matrix could also be used
to record the relationship between the
discrete values, Threat Capability and
Resistance (Control) Strength to
determine the derived Vulnerability. A
Toolbox of elements and relationships is
available for the Risk Taxonomy
diagram allowing sophisticated models
of risk to be created.

(c) Sparx Systems 2018

Page 192 of 275

User Guide - Business Analysis Tools

21 December, 2018

Learn more Risk Taxonomy
about the
Risk
Taxonomy

(c) Sparx Systems 2018

Page 193 of 275

User Guide - Business Analysis Tools

21 December, 2018

Roadmap Diagram
Getting to know the Roadmap Diagram
Introducing The Roadmap diagram is an overlay that
the Roadmap can be applied to any diagram to
Diagram describe significant phases in elements
and how they change with the passage of
time.
Unit: Quarterly
Q4'12

Q1'13

Component Lifecycle
Q2'13

Q3'13

Q4'13

Q1'14

Q2'14

Q3'14

Q4'14

Q1'15

Q2'15

Q3'15

Q4'15

Windows 10

Q1'16

Q2'16

Q3'16

Q4'16

Q1'17

Q2'17

Q3'17

Q4'17

Q1'18

Q2'18

Enterprise Resource Planning System

Customer Manager

This development
represents the
refactoring from a
thick client to a
web-based
interface
maintaining the
server side
component
developed in 2002.

Q4'12

Q1'13

Unit: Quarterly

Capture CRM Hosted Service

The replacement
CRM system will be
implemented and
during this period
adapters will be
configured to
ensure data is
exchanged with a
number of other
systems.

Q2'13

Q3'13

Q4'13

Q1'14

Q2'14

Q3'14

Q4'14

Q1'15

The two
applications
(incumbent and
the replacement)
will be run in
parallel for
approximately 4
weeks or until the
replacement
component can be
fully evaluated.

Q2'15

Q3'15

Q4'15

This diagram shows the use
of a roadmap overlay to
present the lifecycle phases
of the Customer Relationship
components existing and
incumbent systems and the
ERP system which it
interfaces to for sales figures.

Q1'16

Q2'16

Q3'16

Q4'16

Q1'17

Q2'17

Segment Legend
Implementation
Development
Supported Fully
Supported Partially
Support End of Life

Q3'17

Q4'17

Q1'18

Q2'18

Component Lifecycle

There is no restriction on the type of
element that can appear on the diagram,
and any diagram can have a Roadmap
overlay defined. Significant user defined
phases in the element's lifetime are
represented by colored bars, which can
be set to show duration. The colors and
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the phases can be configured using a
Diagram Legend, which automatically
applies them to the elements in the
diagram. They are particularly useful in
Enterprise Architecture diagrams for
describing capability and application
Roadmaps.
Where to Ribbon: Layout > Diagram > Roadmap
find the Diagram Context Menu: Roadmap
Roadmap
Diagram
Usage of the The Roadmap diagram has a wide range
Roadmap of uses in Enterprise Architecture where
Diagram they can be used to show application and
capability roadmaps to Systems
Engineering, where they are used to
show timing in low level components.
Options for The Roadmap overlay has a range of
the Roadmap options that determine the properties of
Diagram the timeline, such as the scale of the time
rulers, units, their positions, and the
appearance of the time line including
fonts and colors. The height and position
of the timeline can also be configured to
suit the diagram and display.
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The Diagram Legend can be configured
to define the phases in the elements
lifetime and to set the specification of the
colored bands and more. Roadmap
segments can be shown or hidden on
individual elements in cases where a
particular segment might not apply to
one or more of the elements on the
diagram.
Learn more Roadmap Diagram
about the
(c) Sparx Systems 2018
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Roadmap
Diagram
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Scenario Builder
Getting to Know the Scenario Builder
Introducing The Scenario Builder is used to define
the Scenario the details of a Use Case including
Builder defining detailed descriptions, creating
one or more Scenarios and defining
pre-conditions, post-conditions and other
constraints. The detailed steps of a Use
Case can be recorded and linked to other
elements in the model and these can then
be generated out as a diagram providing
a visual representation of the Use Case
and its Scenarios. The diagram and the
text can be synchronized and individual
steps can then be traced to other
elements such as Components that will
realize the Requirement specified in the
Use Case.
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Where to Element Context Menu: Properties |
find the Scenarios
Scenario
Builder
Usage of the To define the details of a Use Case and
Scenario its scenarios and constraints, which can
Builder be used to replace the traditional
text-document based approach to
defining Use Cases. This ensures that the
Use Case diagram and the textual details
of the Use Cases and its Scenarios and
Constraints are all contained in the same
model and can be traced. If the Use
Cases are required in a document format
for contractual or process reasons, a Use
Case Report can be generated
automatically from the models using the
in-built documentation engine.
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Options for The Scenario Builder can be viewed as a
the Scenario tabbed or a docked window or in an
Builder element's Properties window. The steps
of a Use Case including its Scenarios can
be automatically generated into a number
of different diagram types available from
the Generate Diagram toolbar icon.

Learn more Responsibilities
about the
Scenario
Builder
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Schema Composer
Getting to know the Schema Composer
Introducing The Schema Composer is a powerful and
the Schema productive tool for working with
Composer information that is shared between
organizations or within organizations.
Many industries, domains and
organizations have defined a shared
information model or schema and
mandate or encourage parties to use this
model when sharing information. The
Schema Composer is a tool that helps
analysts and others to define messages
that comply with the schemas and thus
comply with the mandated formats.

Where to Ribbon: Specialize > Tools > Schema
find the Composer > Open Schema Composer
Schema
(c) Sparx Systems 2018
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Composer
Usage of the The Schema Composer can be used to
Schema work with a number of standards
Composer including:
· The Common Information Model
(CIM)
· National Information Exchange
Modeling (NIEM)
· United Nations Center for Trade
Facilitation and Electronic Business
(UN/CEFACT) Modeling
Methodology (UMM), specifically the
Naming and Design Rules (NDR) 2.1
and 3.0
· Universal Business Language (UBL),
specifically the Naming and Design
Rules (NDR) 3.0
A modeler can however define their own
schema using the tool either for use
within an organization or as part of a
standards or technical committee. Other
standards will be added as more agencies
and industry groups adopt the tool.
Options for The Schema Composer can also be used
the Schema to create a definition of the same
Composer message using a number of different
formats such as:
(c) Sparx Systems 2018
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XSD - (XML Schema Definition)
RDFS - (Resource Description
Framework Schema)
JSON - (JavaScript Object Notation)

Learn more Schema Composer
about the
Schema
Composer
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Security
Getting to know Security
Introducing The Security system in Enterprise
Security Architect is designed to facilitate
collaboration, not as a barrier to
incursion.
The information contained in the
Repository is a valuable organizational
asset that needs to be maintained and
secured as such. The asset must be
protected from both intentional and
inadvertent compromises of content. The
Security system allows update functions
to be restricted to a set of users or groups
with the appropriate defined permission.
Packages, elements and diagrams can be
locked by users, preventing others from
updating them.
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Where to Ribbon: Configure > Security
find Security
Usage of Security has been designed to restrict
Security access to update functions to groups and
users who have been granted the access
permissions to perform these functions.
Packages, elements and diagrams can
also be locked for change by a user under
a single user ID or group user ID,
preventing others from changing them.
The Security system has been designed
primarily to facilitate collaboration and
cannot be used to restrict users from
viewing parts of the model.
Options for Security itself is optional in Enterprise
Security Architect, and by default is not enabled.
If it is required, security can be enabled
and a security policy can be set. There
(c) Sparx Systems 2018
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are two policies that can be set to dictate
the way security functions:
1. Require User Lock to Edit - (More
Rigorous Policy) the whole project is
locked against editing and the user
must deliberately lock an element to be
able to edit it.
2. User/group locking - (Less Rigorous
Policy) the whole repository is
unlocked. When a modeler edits an
element or diagram the element or set
of elements is automatically locked,
preventing others from editing them.

Any number of users and groups can be
defined. Users can be given individual
permissions and also placed into one or
more groups that have additional
permissions defined. The set of
(c) Sparx Systems 2018
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permissions for a user is the sum of their
individual permissions plus those of any
groups they are assigned to. Users can be
defined manually or imported from
Windows Active Directory, allowing
single sign-on using Windows
Authentication.
Learn more Security
about
Security
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Sequence Diagram
Getting to know the Sequence Diagram
Introducing The Sequence diagram is one of the
the Sequence Unified Modeling Language (UML)
Diagram Behavioral diagrams that can be used to
define the time ordered flow of messages
between elements. They can be used by
business and technical users but are more
commonly used for technical
descriptions of a system. Time is by
convention represented on the vertical
axis and elements (Classifiers or
Instances) are positioned horizontally at
the top of the diagram. Commonly an
Actor (representing a role played by a
user) starts the flow and messages are
passed between the elements showing
how a result is achieved.
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A ccounts Manager

Contacts Manager

ai

ai

A ddress

First the list of current
addresses is retrieved.

Next the new address
is added.

A ddress
1.0 getAddressesList(int):
A ddressList

1.1 addAddress(String):
String

This sequence diagram show the how components
communicate. The components have a number of
structural features: each has a port (ai = address
interface) and an interface (Address). The interfaces
have services defined that can be used as the
operation for the message.

Where to
find the
Sequence
Diagram

Ribbon: Design > Diagram > Insert >
UML Behavioral > Sequence
Project Browser Toolbar : New Diagram
icon > UML Behavioral > Sequence
Project Browser context menu | Add
Diagram... > UML Behavioral >
Sequence

Usage of the The Sequence diagram can be used to
Sequence model any set of messages that flow
Diagram between two or more elements to
produce a result. They are more typically
used by technical modelers to depict how
messages are passed between application
components and interfaces to achieve an
outcome. They are particularly useful
when used to describe complex protocols
or subsystem interactions that are
difficult to understand unless presented
graphically. Sequence diagrams can also
(c) Sparx Systems 2018
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be created automatically from stack
traces as a way of visualizing how a
system functions.
Options for The elements that appear in Sequence
the Sequence diagrams can be either Classifiers such
Diagram as Classes and Components or instances
such as Objects and Component
Instances. The choice will depend on
what the modeler wants to represent. The
order of objects and messages can be
altered to make the diagram more
readable and notes can be used to explain
parts of the diagram. Fragments can also
be added to represent control structures
that operate on a group of messages.
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Learn more Sequence Diagram
about the
Sequence
Diagram
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Specification Manager
Getting to Know the Specification Manager
Introducing
the
Specification
Manager

(c) Sparx Systems 2018

The Specification Manager is the central
tool for working with requirements and
provides a Word Processor or
Spreadsheet like interface for entering,
maintaining and viewing Requirements.
New Requirements can be created with
names and detailed descriptions and
properties such as Status and Priority can
be added from drop-down lists. Existing
Requirements can be viewed and
managed in a convenient view and
changing them in the Specification
Manager will change them in all other
places in the repository such as diagrams
and windows. It is the perfect tool for
those analysts more comfortable working
with text rather than diagrams and who
are accustomed to working in a Word
Processor or Spreadsheet. It has the
added advantage that the requirements
are part of a model and can be traced to
other elements including Business
Drivers, Stakeholders and Solution
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Components.

Where to Project Browser Context Menu
find the (Package): View as Requirements List
Specification
Manager
Usage of the To create, view and maintain
Specification Requirements in a text based tool that
Manager resembles working in a word processor
or spreadsheet. Details can be added to
the requirements and requirement
properties can be added from drop-down
lists. When the requirements are changed
in this Specification Manager the
(c) Sparx Systems 2018
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changes are conveniently reflected in the
Project Browser and all other windows.
Options for
the
Specification
Manager

There are a wide range of options
available from the options menu, to tailor
the way you use the Specification
Manager. These include Level
(hierarchical) Numbering, Auto Naming,
Spell Check, Documentation, Import and
Export of Requirements, access to
various related tools and more.

Learn more The Specification Manager
about the
Specification
Manager

(c) Sparx Systems 2018

Page 214 of 275

User Guide - Business Analysis Tools

21 December, 2018

StateMachine Diagram
Getting to know the StateMachine Diagram
Introducing
the
StateMachin
e Diagram

The StateMachine diagram is one of the
Unified Modeling Language (UML)
Behavioral diagrams that can be used to
model the important phases in the
lifetime of an element. It is often thought
of as a diagram for technical uses but it
has equal applicability for non technical
audiences. The StateMachine is defined
for a selected entity in the system and a
perspective is defined that will be
modeled by the States and other elements
and connectors in the diagram.
In Catalogue

order [qty > stock] /reorder

Order [qty <= stock]

Book Released
addToCatalogue

This state machine illustrates
composite states - in which a
super state has nested sub
states to show the detailed
level of states that can exist
within the super state.

OnOrder

In Stock

received

removeFromCatalogue

Removed from Catalogue
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Ribbon: Design > Diagram > Insert >
UML Behavioral > StateMachine
Project Browser Toolbar : New Diagram
icon > UML Behavioral > StateMachine
Project Browser context menu | Add
Diagram... > UML Behavioral >
StateMachine

Usage of the The StateMachine diagram is used to
StateMachin model the important phases in the
e Diagram lifetime of a system entity. It can be used
to model business entities such as Bank
Accounts or technical entities such as a
Traffic Light Control system.
Options for
the
StateMachin
e Diagram
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The StateMachine diagram can be
automatically converted to an analogous
model in a State Table Editor. This can
be an appealing representation for some
users and the editor provides an easy to
use interface to add new States and
Transitions. StateMachine diagrams and
Tables can be used to create Model
Simulations that will allow the modeler
to visualize, explore and test the dynamic
behavior of the StateMachine.
StateMachines can also be used to
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generate code into Hardware Description
Languages (HDL).

The StateMachine diagram (like any
diagram) can be viewed as an Element
List, which makes working with the
element's properties easier.
Diagram Filters can also be used when
presenting the diagrams to draw attention
to parts of the diagrams and the diagrams
can be presented as hand drawn or in a
whiteboard style by changing the
(c) Sparx Systems 2018
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properties of the diagram.
Learn more StateMachine Diagram
about the
StateMachin
e Diagram
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Stereotyping
Getting to know Stereotyping
Introducing Stereotypes are one of the Unified
Stereotyping Modeling Language Extension
Mechanism that can be used to create a
new type of element based on an existing
UML element type. There are many
cases where things of interest in a
particular industry or domain would
benefit from being defined as a type. The
stereotyped elements often add clarity to
a model and are meaningful to a model
audience who is familiar with their
domain. Examples include a 'contract'
stereotype in the legal profession, a
'policy' stereotype in the compliance
profession or a 'meter' stereotype in the
energy distribution industry.
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Stakeholder Requirements
This diagram shows a number of stakeholders and their needs (requirements).
A stereotype has been created for the stakeholders, that has an alternate image assigned to it.
The requirements are displayed using a rectangular presentation style, so as to display the
stereotype <<stakeholder requirement>> in the diagram.

Operations
Manager

«stakeholder requirement»
REQ118 - The solution must reduce
the need for paper records to be
created and kept.

«stakeholder requirement»
REQ119 - The solution must comply
with enterprise customer
experience and useability standards

Customer
Experience
Manager

Chief
Financial
Officer

«stakeholder requirement»
REQ120 - The solution must support
internationalization as prescribed in
the global enterprise policies
document

«stakeholder requirement»
REQ121 - The solution must result in
increased revenue in the second
year of operation

Where to Defining Stereotypes
find Ribbon: Configure > Reference Data >
Stereotyping UML Types > Stereotypes
Using Stereotypes
Element Properties Sheet: Stereotype
Usage of Stereotypes can be used to help define
Stereotyping canonical types of things in a domain.
Once defined the stereotypes can be
applied to the elements in a repository to
make the elements more meaningful and
recognizable to an audience. The use of
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images and shapes can make the
resulting models more appealing and
understandable to audiences. Care should
be taken not to overuse the facility as it
can lead to fragmentation of meaning
and also can result in models that are not
understood by external audiences.
Options for Stereotypes can have a number of
Stereotyping appearance settings applied that help to
distinguish the element type. These
include changing the default colors of the
element, or changing the appearance by
assigning an image or a new shape to
elements with the applied stereotype.
The image is best defined in a vector
format such as a metafile, so that when it
is resized the image doesn't become
pixelated. A Shape Script can be defined
that uses a user defined script to draw the
element, effectively allowing any style of
element to be drawn and conditionally
adding graphic features based on
properties and Tagged Values.
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Learn more Stereotypes
about Stereotype Settings
Stereotyping
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Strategy Map
Getting to know the Strategy Map
Introducing A Strategy Map is a diagram that is used
the Strategy to describe the primary strategic goals
Map that are important to an organization or
business team. The diagram shows four
important perspectives that are the
significant questions that provide the
definition of a strategy. The most
commonly defined perspectives are:
‘Financial’, ‘Customer’, ‘Internal
Business Processes’, ‘Learning and
Growth’. The diagram is used as a
communication device to ensure there is
a common understanding of the strategy,
to focus organization effort and to assist
with the assessment of progress.
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Fin an cial Perspective
Long-Term
Shareholder Value

Productivity Strategy

Improve Cost
Structure

Growth Strategy

In crease A sset
Utilization

Expand Revenue
Opportunities

En h ance Customer
Value

C u sto mer Perspective
Customer Value Proposition
P rice

C o nsistent Quality

High A vailability

Titles Selection

Service Excellence

P artnership

Relationship

Product or Service
A ttributes

Brand

Image

In tern al Perspective
Operations Management
Processes
D istribution
Production
Risk
Supply

Customer Management
Processes

Innovation Processes
D esign/Develop
Lau nch
Opportunity ID
R&D Portfolio

A cquisition
Growth
Retention
Selection

Regulatory and Social
Processes
Community
Employment
Environment
Safety and Health

Learning and Growth Perspective
H u man Capital

Information Capital

Organization Capital
Culture

Where to
find the
Strategy
Map

Lead ership

A lignment

Teamwork

Ribbon: Design > Diagram > Insert >
Strategic Modeling > Strategy Map
Project Browser Toolbar : New Diagram
icon > Strategic Modeling > Strategy
Map
Project Browser context menu | Add
Diagram... > Strategic Modeling >
Strategy Map

Usage of the The Strategy Map is used to model the
Strategy key strategic goals that an organization
Map or management team intend to achieve.
(c) Sparx Systems 2018
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Elements in each of the four perspectives
can be linked to other elements in the
repository to show how they could be
implemented at a business, application or
technology level.
Options for A Strategy Map can be created using
the Strategy Patterns that automatically create
Map elements and a diagram that can be used
as a starting point for the Strategy Map.
There are three Patterns available,
ranging from a very simple expression
with a single element in each perspective
to a completely worked expression with
multiple elements in each perspective. A
toolbox provides a range of additional
elements and relationships to extend the
base maps created using the Patterns.
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Learn more Strategy Map
about the
Strategy
Map
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Tagged Values
Getting to know the Tagged Values
Introducing Tagged Values are one of the Unified
the Tagged Modeling Language's built-in extension
Values mechanisms. They provide a useful and
productive way of adding extra
properties to elements, attributes,
operations or connectors; just as you
would add an additional column in your
favorite spreadsheet. They have a Tag
name and a Value, and additional Notes.
You can use a wide range of user
interface controls to assist users when
entering a value for the tag, such as drop
downs, spin controls, date and color
pickers, and more.

There are a variety of properties
available for elements in the Repository,
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including name, notes, status, author and
version. Even with these properties
available, it is likely that an analyst will
need to add additional properties in some
situations, and the Tagged Values facility
is an easy to use and productive
mechanism for working with these
properties.
Where to Defining Tagged Values
find Tagged Ribbon: Configure > Reference Data >
Values UML Types > Tagged Value Types
Using Tagged Values
Ribbon: Start > Explore > Properties >
Tagged Values
Usage of the Tagged Values are additional properties
Tagged (and their values) that can be set for any
Values UML element, attribute, operation or
connector. For example a Requirement
element does not have a built in property
for volatility and so a Tagged Value
could be added providing the user with a
drop down list of available values: such
as High, Low, Medium.
Tagged Values are used extensively in
profiles and technologies. For example
you will use them when working in the
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BPMN Technology to set properties of
Activities or in the Wire Framing
Technology to show or hide phone menu
buttons and notification bars.
Options for There are built in Structured Tagged
the Tagged Value Types that help the user when
Values entering the value for a tag. The values
can be restricted using user interface
controls such as drop down lists, spin
controls, date selectors and many more.

For example a date picker can be applied
to allow a user to select the date a
Change was authorized.
Learn more Tagged Values
about the
Tagged
Values

(c) Sparx Systems 2018

Page 229 of 275

User Guide - Business Analysis Tools

(c) Sparx Systems 2018

21 December, 2018

Page 230 of 275

User Guide - Business Analysis Tools

21 December, 2018

Team Library
Getting to know Team Library
Introducing The Team Library provides an
Team opportunity for developers, modelers,
Library customers and stakeholders to comment
and provide feedback on the work in
progress or at the completion of a
milestone or project.

Usage of The Team Library feature can be used to
Team conduct model reviews from any number
Library of perspectives, including walk-throughs,
formal model reviews, or ad-hoc
reviews.
Where to
find Team
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Library
Options for There is a wide range of settings
Team available to configure the Team Library
Library available from the Category and Topic
context menus, including setting the
status of the category or topic and other
options. Diagrams, elements and element
features can be conveniently dragged
from the Project Browser to create model
links that can be used by team members
to hyperlink directly from the Team
Library window to these items in the
Project Browser.

Learn more Team Library
about Team
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Library
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Testing
Getting to know Testing
Introducing Enterprise Architect has a number of
Testing tools that can be used for modeling
aspects of the test discipline. The Testing
Window is the central tool for creating
and managing tests, allowing a range of
different test types to be defined,
including properties such as Status and
the results of tests to be recorded.
«user story»
As a Stock Control Manager I want to be able to list stock levels
for a selection of titles.
requirements
A user must be warned when the report generation time is going to be
more than one minute.
Back ordered titles must only be included in total when the available
stock is zero.
constraints
{The solution must use available Stored Procedures}
Volatility = High

tags

test scripts
System
No titles selected
Two titles selected one with no stock

Fa il
Deferred

A cceptance
Five non contiguous titles selected

Pa ss

maintenance

D ecision
Display back order as negative stock

Verified

ToDo
C reate application logic to display results in a table
C reate table index to ensure fast retrieval of stock levels
Decide on Ux mechanism to multiselect a number of Ti...

New
Verified
New

Stock
Control
Manager

User Story modeling and
test management in Sparx
Systems Enterprise
A rchitect
This diagram shows an
element with a variety of
compartments displayed.
This is useful when using
diagrams to communicate
other information stored in
the repository. Enterprise
Architect has a large set of
extra information that can
enrich the models and
provide other disciplines
such as project managers
and testing analysts a
place to store important
project information.
User Stories : Manage
Inventory User Story
Element C ompartments

Where to Ribbon: Construct > Testing > Test
find Testing Windows > All, Inspection, Unit,
Integration, System, Acceptance,
Scenario
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Element Browser: | Testing | All,
Inspection, Unit, Integration, System,
Acceptance, Scenario
Usage of The Testing window allows a number of
Testing different types of tests to be created and
managed. These support the most
common types of testing, and include:
· Unit tests - to test Classes,
Components and other elements as
they are implemented
· Integration tests - to test how the
implemented artifacts and components
work together
· System tests - to test that the system
performs the right business functions
correctly
· Acceptance tests - to test the system
against user requirements and
acceptance and evaluation criteria
· Scenario tests - to test the application
with real-world situations and
scenarios
· Inspection tests - to record peer
reviews using a well-defined process
Options for The Testing Window allows a modeler to
Testing record metadata for the tests, including:
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The name of the Test
The status of the test
Who the Test was run by
The Type of Test (such as Regression)
Who it was Checked by
The Class of Test (such as
Acceptance)
The Date it was last run
Description of the Test
Inputs required
Acceptance Criteria
Results

Learn more Testing
about
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Testing
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Traceability Window
Getting to Know the Traceability Window
Introducing
the
Traceability
Window
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The Traceability window gives the
modeler a hierarchical view of element
connections, allowing traceability to be
visualized and queried as elements are
traversed in the model. This tool is
particularly powerful because a modeler
will often choose to hide diagram
relationships but by selecting an element
in the diagram and viewing its
connections in the traceability window
all its relationships will be displayed.
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Where to Start > Explore > Trace > Traceability
find the
Traceability
Window
Usage of the The Traceability Window can be used to
Traceability view the way an element is connected to
Window other elements in the repository, in a
hierarchy including the types of the
relationships. This window gives a
complete list of all relationships that
cannot be seen by viewing elements in
the Project Browser and that might not
appear in any diagrams. It is very useful
for managing requirements and tracing
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how a requirement is related to
up-process elements such as Business
Drivers and down-process elements such
as Components. It is a useful tool for
newcomers to a model to gain a quick
understanding of which are the important
and well connected elements. It should
be viewed before deleting an element in
the model to ensure that the user
understands the element's existing
relationships.
Options for
the
Traceability
Window

There are a series of options that restrict
the traceability to specified connector
types; these can be set to alter what is
displayed in the window. The options are
available from the toolbar at the top of
the window.

Learn more The Traceability Window
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about the
Traceability
Window
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Use Case Diagram
Getting to know the Use Case diagram
Introducing The Use Case diagram is one of the
the Use Case Unified Modeling Language (UML)
Diagram Behavioral diagrams that can be used to
describe the goals of the users and other
systems that interact with the system that
is being modeled. They are used to
describe the functional requirements of a
system, subsystem or entity and present a
simple but compelling picture of how the
system will be used.
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Online Bookstore

Add New Titles

Manage Publishers

Use Case diagrams can be
created showing the system as
a Boundary that contains the
Use Cases. There is a
sophisticated editor that can
be used to detail the steps of
scenarios including
constraints. A behavior
diagram can be automatically
generated from a scenario
that allows the steps
described in the scenario to be
visu alized.

Manage Titles
Products Manager

Chief Editor

Create Orders
On-line Customer

List Stock Levels
Customer Support Officer

They are typically used in conjunction
with higher level Business and
Stakeholder Requirements and are often
supplemented with a set of Non
Functional Requirements.
Where to
find the Use
Case
Diagram

Ribbon: Design > Diagram > Insert >
UML Behavioral > Use Case
Project Browser Toolbar : New Diagram
icon > UML Behavioral > Use Case
Project Browser context menu | Add
Diagram... > UML Behavioral > Use
Case

Usage of the The Use Case diagram is used to
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Use Case describe the goals that users or other
Diagram systems want to achieve from interacting
with the system. They always describe
the goal from the Actors' perspective, the
details of the Use Case will describe the
goal with more precision.
Use Cases will often act as the basis for
the definition of Test Cases.
Options for Any number of Use Case diagrams can
the Use Case be created to represent different parts of
Diagram a system or Packages of Use Cases. The
diagrams can be kept simple or they can
be structured by the application of a
number of additional connectors such as
Include, Extend and Generalization
relationships.
A system Boundary can be included that
is used to name the system, subsystem or
entity under discussion; the Actors lie
outside the Boundary and the Use Cases
inside.
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REQ0165 - The solution
must allow items to be
added to the inventory

REQ164 - The solution
must have the ability to
manage inventory items

REQ0166 - The solution
must allow inventory
items to be edited

REQ0167 - The solution
must allow inventory
items to be soft deleted
Manage Titles

«satisfy»
Inventory Manager

Manages titles including
providing services to add,
delete and modify titles and
advanced sort and filter
services.

This diagram shows the
expressive power of putting
disparate elements onto a
diagram to show the
traceability between
different layers of a system.
The traceability can be from
the Requirements to the Use
Cases that Realize them to
the logical Components that
will deliver the required
functionality and more.

Use Case diagrams can be used to show
how the Use Case are related to other
elements in the system, including
up-stream elements such as
Requirements and down-stream elements
such as Components.
The Use Case diagram (as for any
diagram) can be viewed as an Element
List, which makes working with the
element's properties easier.
Diagram Filters can also be used when
presenting the diagrams, to draw
attention to parts of the diagrams and the
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diagrams can be presented as hand drawn
or in a whiteboard style by changing the
properties of the diagram.
Learn more Use Case Diagram
about the
Use Case
Diagram
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Use Case Estimation
Getting to know Use Case Estimation
Introducing Use Case Estimation is a comprehensive
Use Case project estimation tool that is used to
Estimation calculate effort using Use Case and
Actor elements. The complexity of the
work environment is set using a series of
weighted Technical and Environmental
Complexity factors and Use Cases and
Actors are given a rating that assigns
their complexity as: Easy, Medium or
Complex. The method is based on
Karner's Use Case Points Method, and
allows a metrics report containing the
project estimation analysis to be
produced and incorporated into project
documentation.
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Where to Ribbon: Configure > Reference Data >
find Use Project Types > Estimation Factors
Case
Estimation
Usage of Use Use Case Estimation can be used to
Case calculate the required effort to complete
Estimation an initiative or part of an initiative.
Options for Environmental and Technical complexity
Use Case factors can be defined and given weights
Estimation and values that determine how they
influence the effort that is calculated for
an initiative.

(c) Sparx Systems 2018

Page 248 of 275

User Guide - Business Analysis Tools

21 December, 2018

A value can be assigned to the phase
property of one or more Use Cases; this
value can be used subsequently as the
criteria of a filter to restrict the estimates
to just that phase. The estimate can also
be filtered based on a Tagged Value set
on the Use Cases such as Criticality.
Learn more Use Case Estimation
about Use
Case
Estimation
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User Story
Getting to know the User Story
Introducing User Stories are most often associated
the User with iterative processes and were
Story originally defined by Extreme
Programming techniques. They are now
more commonly associated with a
number of Agile processes. A User Story
typically consists of a simple statement
made in a few short sentences describing
what the user does or needs to do to
achieve a goal and why the goal is
important to them. They are typically
written to replace detailed traditional
requirements and allow developers to
understand the goals of a user and what
their job functions entail.
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FEA007 - Transfer
Management

«trace»
«user story»
As a Stock Control
Manager I want to be able
to list stock levels for a
selection of titles.
Customers often order a
number of titles particularly
students buying a list of
books at the commencement
of the academic year. It is
important to be able to view
stock for a list of titles at the
same time.

FEA008 - Threshold and
Level Controls

FEA009 - Supplier
Integration

«trace»
REQ171 - The solution must
allow stock levels to be
managed

REQ172 - Manage stock
levels for a selection of
titles

Business Analysis with user stories modeled
in Sparx Systems Enterprise Architect
This diagram shows how a User Story can be
modeled using a stereotyped Use Case. This
allows the User Story to be described and to
show the connection to a Persona. As a Sprint
is being defined detailed Requirements can
be developed just-in-time for the
development work to begin.

Where to Toolbox Page: Artifacts | User Story
find the User
Story
Usage of the User Stories are useful as an alternative
User Story way of describing user requirements.
They are used as part of certain Agile
processes, to provide a simple but clear
description of what the user does or
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needs to do as part of the role they
perform. They also typically describe the
reason behind the goal the user wants to
achieve.
Options for A User Story can be created using the
the User stereotyped Artifact available from the
Story 'Artifact' Toolbox page or as a
stereotyped Use Case. While many
proponents of User Stories see them
differently to Use Cases, they are both
aimed at defining a goal that a user in a
role wants to achieve. A stereotyped Use
Case can also be used to represent a User
Story with just the description written in
the form: 'As a (Stock Controller) I want
to be able to... '. They can be defined in
conjunction with Personas that help to
allow analysts to empathize with the
users.
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Learn more User Story
about the
User Story
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Value Chain
Getting to know the Value Chain
Introducing The Value Chain is a strategic diagram
the Value that allows the primary and secondary
Chain activities in an organization to be
modeled. The diagram can be created
from a Pattern that adds and connects the
five primary activities in a chain and the
four supporting activities underpinning
them.
Firm Infrastructure

Human Resource Management

Technology Development

Procurement

Inbound
Logistics

Operations

Outbound
Logistics

Marketing &
Sales

Service

Legend
Gross Sales
Support Activities
Primary Activities
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An analyst working at the strategic
business unit level will often be asked to
model the activities the business unit
performs to provide value to its
customers. The Value Chain is the
preferred tool for creating this strategic
representation of the sequence of
activities that an organization performs.
Where to Ribbon: Design > Diagram > Insert >
find the Strategic Modeling > Value Chain
Value Chain Project Browser Toolbar : New Diagram
icon > Strategic Modeling > Value Chain
Project Browser context menu | Add
Diagram... > Strategic Modeling > Value
Chain
Usage of the The Value Chain is an important tool to
Value Chain assist with strategic planning allowing
the whole sequence (or chain) to be
understood. It also allows the chain to be
broken down into its constituent
activities allowing the evaluation of
costs, resource and value to be
determined and potentially improved.
Options for Each one of the Primary and Supporting
the Value Activities can be linked to other elements
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Chain in the model including a Linked
Document and elements that define
benchmarks.

The Value Chain diagram (like any
diagram) can be viewed as an element
list which makes working with the
element's properties easier.
Diagram Filters can also be used when
presenting the diagrams to draw attention
to parts of the diagrams.
Learn more Value Chain
about the
Value Chain

(c) Sparx Systems 2018

Page 256 of 275

User Guide - Business Analysis Tools

21 December, 2018

Visual Filters
Getting to know Visual Filters
Introducing Visual Filters provide a mechanism for
the Visual filtering out parts of a diagram or list of
Filters elements that are not of interest, leaving
just the elements and connectors that are
relevant to the view. The filters can be
defined for elements or connectors and
there is a wide range of criteria that can
be set, such as filter out all elements that
don't have a status of 'Validated' and
were created since a milestone date.
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Model stakeholders typically have
different interests and often only part of
a diagram or element list will be relevant
to them. Visual filters can assist by
allowing you to filter out parts of a
diagram or list of elements leaving just
the elements and connectors that they
want to see. This is a powerful tool in
workshops, focus groups and meetings
allowing a modeler to present a single
diagram in many different ways.
Where to Ribbon: Layout > Tools > Diagram
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find the Filters
Visual Filters
Usage of the Visual Filters can be defined at a
Visual Filters Repository level making them available
to all users. The application of the filter
is however specific to the current user, so
two analysts could apply different filters
to the same diagram or list
simultaneously.
Options for There are a number of options available
the Visual from the Visual Filters Toolbar including
Filters being able to change the way the element
obscuration is presented from: Fade,
Gray Scale, Hide and Select.

Context filtering can be applied so that
only the element selected in the diagram
and its directly connected elements will
be enabled, this can be enabled from the
Visual Filters window Context Menu.
The filtering effect can be to hide, fade
or gray scale the irrelevant elements; the
Select option will conversely select the
elements of interest in the diagram or list.
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Learn more Visual Filters
about the
Visual Filters
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Wire Frame Diagram
Getting to know the Wire Frame Diagram
Introducing
the Wire
Frame
Diagram
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Wire Framing is a productive tool that
can be used to create visually compelling
and realistic models of commercially
available phones, tablets, screens and
web pages. The diagrams assist Business
Analysts, Experience Designers and
others communicate with stakeholders,
allowing them to demonstrate the
solution interfaces.
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Sales Lead Resolver

5:56 PM

Joe Blow Enterprises
Lead One

«trace»

Lead Two
Lead Three
Acme Inc.

The Sales Lead Resolver
manages all aspects of
sales leads including
current and historical
leads.
REQ129 - The solution
must allow historical sales
leads to be managed.

Lead One
Lead Two
John Smith Inc.
Current
History
View Details

«trace»

It is quite common for
sales leads to go cold for
a period of time which
could be up to twelve
months and then when
circumstances change
these leads need to be
followed up on. So it is
critical that these can be
managed in the office
and the field.
(from Customer Relationship
M anagement)

This diagram shows the rich support for creating wireframe models of modern
portable devices such as cell (mobile) phones and tablets. The toolbox has rich
support for a wide range of pre-built controls applicable to the main types of
devices in use including Apple and Android devices. Parts of the interface can be
linked to other elements in the repository creating powerful traceability.

Many stakeholders will understand how
a solution is going to work if they can
see something concrete and visual. The
Wire Framing tool is perfect for this
situation where a mock-up of the user
interface of a phone, tablet or web page
is created including page layout,
interface and navigational controls
representing different parts of a User
Story or Use Case.
Where to Ribbon: Design > Diagram > Insert >
find the Wire Wireframing > Apple, Android, Dialog,
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Frame Webpage, Windows Phone Wireframe
Diagram Project Browser Toolbar : New Diagram
icon > Wireframing > Apple, Android,
Dialog, Webpage, Windows Phone
Wireframe
Project Browser context menu | Add
Diagram... > Wireframing > Apple,
Android, Dialog, Webpage, Windows
Phone Wireframe
Usage of the A Business Analyst or Experience
Wire Frame Designer will typically create Wire
Diagram Frame models for the devices that are
being targeted in the solution. The
interface elements and navigational
controls can be connected to other
elements in the Repository. For example
a drop down list could be connected to a
data source indicating the origin of the
data. A slide show could also be created
to walk a stakeholder through a sequence
of diagrams representing the flow
through a User Story or Use Case.
Options for There are built in toolboxes for the most
the Wire common types of devices, including:
Frame · Android Phones and Tablets
Diagram · Apple iPhones and Tablets
· Windows Phones
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Screen Dialogs
· Webpages
The toolboxes contain elements for the
devices, pages and screens and a wide
range of controls, widgets and other
elements. Tagged Values can be set to
hide or display elements of the interface
such as phone menu buttons and
notification bars.
·
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Diagram Filters can also be used when
presenting the diagrams to draw attention
to parts of the diagrams, and the
diagrams can be presented as hand drawn
or in a whiteboard style by changing the
properties of the diagram.
Learn more Wire Framing
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about the
Wire Frame
Diagram
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Working Sets
Getting to know Working Sets
Introducing Working Sets are a powerful way of
Working saving a group of Workspace items such
Sets as diagrams and matrices so they can be
re-opened as a set at a later time. This
allows a modeler to switch between
multiple tasks without losing the context
of the items they are working on.

A Business Analyst will often work on a
number of tasks simultaneously and each
task will typically require the application
of a number of techniques and tools
including diagrams, matrices, documents
and more. Working Sets allow a user to
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save groups of windows and diagrams
they are working on as a set, giving the
group a name so it can be easily recalled
and the items opened as a set at a later
time.
Where to Ribbon: Start > View > Workspace > My
find Working Sets...
Working
Sets
Usage of Working Sets can be used to store a
Working group of items open in an Enterprise
Sets Architect workspace as a set that can be
reopened at a later time. A typical
scenario is that a Business Analyst is
working on a particular task and has a
number of relevant diagrams and
matrices and documents open that define
parts of a problem or solution for a
particular initiative. Suddenly they
receive an urgent request to complete an
unrelated task. They could save the open
items as a Working Set so that once the
urgent matter had been attended to the
group of items could be easily reopened.
Options for Working Sets allow a number of
Working different items to be added to a set
Sets including:
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Diagrams
· Matrix Profiles
· Searches
· Team Library
· Document Templates
· Resource Documents
Any number of each type of item can be
added to a Working Set and the contents
of the set can be edited and diagrams can
be located in the Project Browser.
·

There are a range of options available
from the 'Working Set <name>' context
menu including being able to make the
working set available to other model
users by choosing the 'Share' option.
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Learn more Working Sets
about
Working
Sets
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XML Schema Generation and Import
Getting to know XML Schema Generation
and Import
Introducing
XML
Schema
Generation
and Import
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The XML Schema Generation and
Import is a built-in facility to model,
forward engineer and reverse engineer
XML Schemas. XML Schema Definition
(XSD), also known as XML Schema, is a
World Wide Web Consortium (W3C)
XML technology and is used in a wide
range of industries to encourage
standards compliance and messaging
using a common schema. The XSD
specifies the rules to which an XML
document must adhere and can be
automatically validated by a number of
tools.

Page 271 of 275

User Guide - Business Analysis Tools

21 December, 2018

Where to Ribbon: Code > Tools > XSD > Import
find XML XSD, Export XSD
Schema
Generation
and Import
Usage of
XML
Schema
Generation
and Import

The XML Schema Generation and
Import facility can be used to visualize
or create a model of an XML Schema
(XSD). This is particularly useful when
the repository is describing shared
messages or a schema that is based on a
standard.

Options for An XML Schema can be created using
XML an in-built model transformation applied
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Schema to an abstract Class diagram or it can be
Generation modeled using the XML Schema
and Import Toolbox page using a Class diagram.
Either way the completed schema model
can be generated to create an XSD file
using names and details specified in the
Tagged Values of the Schema Package.
There is also a purpose built tool for
working with schemas called the Schema
Composer, which allows messages to be
created based on part of a schema.

Learn more XSD Models
about XML
Schema
Generation
and Import
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